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About the User's Manuals
The following manuals are included with the machine.

Setup Guide (Paper Manual)

This manual provides instructions for machine setup and software installation.

User's Manual, Basic Edition (Electronic-format Manual)

This manual provides instructions for basic machine operation and maintenance.

User's Manual, Application Edition—Windows Version (Electronic-
format Manual)

This manual provides instructions and tips for using the GR-640/GR-540/GR-420
and its included software to create various products. 
The Windows version of the application edition provides procedures that use a
computer on which Windows is installed.

User's Manual, Application Edition—Macintosh Version (Electronic-
format Manual)

This manual provides instructions and tips for using the GR-640/GR-540/GR-420
and its included software to create various products. 
The Macintosh version of the application edition provides procedures that use a
Macintosh computer made by Apple.

CutStudio Help (Electronic-format Manual)

This documentation explains details for functions of the included CutStudio software.
To open the Help files, from the Help menu in CutStudio, click Contents.

 

 



Getting Started
Thank you very much for purchasing this product.

Important Notes on Handling and Use

This machine is a precision device, so handle this machine carefully and never subject it
to impacts or excessive force. 
There are additional precautions related to this product's handling and installation site. 
For details, see the setup guide of this machine.

Storing Important Data

Roland DG Corp. assumes no liability for any loss or damage of data resulting from
computer malfunction or damage. 
Always back up important data.

Support

Support information made available via the Roland DG Corp. website is updated
regularly to provide a useful reference in the event of a problem. 
Before contacting us, refer to the information on the website together with
"Troubleshooting."
http://www.rolanddg.com/

Trademark Notice

Company names and product names contained in this manual are trademarks or
registered trademarks of their respective holders.

 

Note that URLs contained in this manual are subject to change without notice.

http://www.rolanddg.co.jp/


What Is the GR-640/GR-540/GR-
420?

What the GR-640/GR-540/GR-420 Can Be Used For

Loadable Materials/Cuttable Area

Part Names

Carriage LED Lamp



What the GR-640/GR-540/GR-420 Can Be
Used For

Cutting Characters and Shapes Cleanly   Making Stickers by Connecting to a
Printer

 

Simple! Basic Cutting

Sending Data from Illustrator/CorelDRAW
 

Printing and Cutting

Preparations for Printing and Cutting (When Using
CutStudio)

Preparations for Printing and Cutting (When Using
Illustrator)

Preparations for Printing and Cutting (When Using
CorelDRAW)

Cutting Perforated Lines on a Variety of
Materials

  Handling Large Output Smoothly

 

Cutting Perforated Lines

Outputting Perforated Line Data from Illustrator

Outputting Perforated Line Data from CorelDRAW

  Tiled Output

 



CAUTION

Loadable Materials/Cuttable Area

Loadable Material Sizes
 

Model name Width Length

GR-640 156 to 1,802 mm
(6 to 70 inches)

Roll material: no restriction

Flat material: 200 mm or more
GR-540 156 to 1,548 mm

(6 to 60 inches)

GR-420 156 to 1,224 mm
(6 to 48 inches)

 

Never load media that weighs over 40 kg (88.19 lb.). 
The machine may fail to withstand the weight, causing
the machine to tip over or the material to fall.

A) Cuttable material thickness

Material thickness of 1 mm or less*

B) Material thickness (including carrier paper)

2 mm or less*



* Conditions differ according to the type of blade.

Refer to "General Guide Regarding Cutting Conditions."

Cuttable Area
 

Model name Maximum cutting area

GR-640
Width: 1,651 mm (65 inches)(*)

Length: 24,998 mm

GR-540
Width: 1,397 mm (55 inches)(*)

Length: 24,998 mm

GR-420
Width: 1,075 mm (42.3 inches)(*)

Length: 24,998 mm

* The maximum width can be extended by up to 20 mm depending on settings.
However, this may cause the pinch roller to leave marks on the products. Exercise
caution. For instructions on how to extend the cutting area, refer to "Extending the
Cutting Area <EXTEND>."

Explanation of Cutting Area

The cutting area along the material's horizontal plane (the direction in which the
cutting carriage moves) is determined by the position of the pinch rollers. The
cutting area spans the length between the two rollers, minus approximately 1 mm
on each side.

Type of specified material Cutting area

[ROLL] or [EDGE]
<Width>: Distance between the two pinch rollers minus
approximately 1 mm on each side
<Length>: 24,998 mm

[PIECE]
<Width>: Distance between the two pinch rollers minus
approximately 1 mm on each side
<Length>: Detected length(*)

*: If the detected length is 1,600 mm or more, the machine determines the material
to be [ROLL], and the length of the cutting area is set to 24,998 mm.
However, the display does not show the length.



*: For the range for assured accuracy,
refer to the specifications.

 : Cutting area
 : Pinch roller

Using Various Types of Materials



Part Names

Main Unit

Front

 

Number Name Description

1 Left pinch roller
To raise or lower this part, press ［PINCH］. This part lowers to
pinch the material. 
Set this at the left edge of the material.

2

Middle pinch rollers
(the number of which varies
depending on the size of the
machine)

To raise or lower these parts, press ［PINCH］. These parts
lower to pinch the material. 
Set these in the middle of the material.

3 Right pinch roller
To raise or lower this part, press ［PINCH］. This part lowers to
pinch the material. 
Set this at the right edge of the material.

4 Operation panel Use the display and the keys to operate and set this machine.

5 Cutting carriage Install the blade holder. 
This part moves to the left and right to cut the material.

6 Power switch Turns the machine's power on and off.

7 Ruler Set the material in place so that its right edge is aligned with the
front and back rulers.

8 Grit pattern
These indicate the locations of the grit rollers. When loading the
material, be sure to place the pinch rollers within the area
indicated by each of these patterns.

9 Blade protector This protects the tip of the blade during cutting.
10 Grit rollers These rollers feed the material to the front and rear.

11 Platen This is the path over which the material passes. A suction fan
that keeps the material from coming loose is built in.



Back

 

Number Name Description
12 USB connector This is for connecting a USB cable.
13 Ethernet connector This is for connecting an Ethernet cable.
14 Power-cord connector This is for connecting a power cord.
15 Material basket This receives and stores the material that is cut from the roll.

 

 

Operation Panel
Use this to set and operate the machine.

Number Name Description Notation used in
this document

16 PINCH key
Use this to raise and lower the pinch rollers. Use this when
inserting or removing the material. 
When the pinch rollers are lowered, this key lights.

[PINCH]

17 Display This displays various setting menus and other information. - - -

18 Cursor keys You use these to select settings for menu items, to move
the material, and for other such operations.

［ ］ ［ ］
［ ］ ［ ］

19 CUT CONFIG key
Use this to set cutting conditions such as the blade force
and the cutting speed. 
Perform a cutting test to check the conditions you have set.

[CUT CONFIG]

20 ORIGIN key Use this to set the origin to the current blade position. 
Hold down this key for one second or longer.

[ORIGIN]

21 PAUSE key
This pauses printing operation. Press it again to restart
operation. 
This lights when operation is paused.

[PAUSE]

22 SHEET CUT key Use this to cut the material from the roll. Hold down this [SHEET CUT]



key for one second or longer.

23 PEN FORCE slider Use this to fine-tune the blade force. You can even perform
this adjustment while cutting is in progress.

- - -

24 MENU key

The message on the display changes each time that you
press this key. The display switches in the following order:
currently set cutting conditions → menu mode → width
display screen.

[MENU]

25 MEMORY key
Use this key to apply recorded cutting conditions to the
settings of the machine and to record the current setting
values to the machine.

[MEMORY]

26 ENTER key You use this for such tasks as enabling setting values. [ENTER]

Carriage LED Lamp



Carriage LED Lamp

Normal

The blue lamp is steadily lit or flashes.

 

Error

The red lamp flashes and an error message is displayed. 
Refer to "Error Message List" and clear the error.



Simple! Basic Cutting

Performing Cutting
Let's learn basic cutting operations. When you follow the procedure, you can create
a sticker like the one shown in the figure below.

 

Items Required Other Than the Machine

A computer with CutStudio installed Roll material

CutStudio

Be sure to install this program.

http://startup.rolanddg.com/

Material

Loadable Materials/Cuttable Area

 

Procedure

http://startup.rolanddg.com/


Loading Roll Material

Installing the Cutting Tool

Performing a Cutting Test

Setting the Origin

Creating Cutting Data (1)

Creating Cutting Data (2)

Entering Characters and Shapes

Saving Cutting Data

Performing Cutting

Removing the Material



CAUTION

CAUTION

CAUTION

Loading Roll Material

Load roll media correctly. 
Otherwise the media may fall and cause injury.

Roll media weighs about 40 kg (88.19 lb.). To avoid
injury, handle it with care.

Never load media that weighs over 40 kg (88.19 lb.). 
The machine may fail to withstand the weight, causing
the machine to tip over or the material to fall.

If using flat material or similar material, refer to "Using Various Types of Materials"
and load the material.

Procedure

Switch on the power.

The power turns on and the cutting carriage moves to the right edge. 
Exercise caution to avoid touching the cutting carriage.



Place the roll material on the shaft at the back of
the machine.

Pull the roll material out to the front of the
machine.

Release the brake, and then pass the leading edge of the roll material
between the pinch rollers and the grit rollers.

Exercise caution to prevent the
material from touching the shaft of
the pinch rollers. 
The shaft is coated in grease, so
grease may be transferred from
the shaft surface to the material if
they come in contact with each
other. 

1:  Machine front
2:  Machine back
3:  Brake
4:  Roll material
5:  Pinch rollers
6:  Grit rollers
7:  Pinch roller shaft



Pull out a length of material that is slightly long, leaving some
slack.

If you load the material without creating some slack, the
material cannot be fed correctly.

Place the right edge of the roll material over the
grit roller (on the right edge).

 

1:  Grit roller
2:  Right edge of the roll material

 

Slide the roll material to place its left edge over the
grit roller.

At this point, check that the right edge of the roll material remains over the
grit roller on the right edge.



 

1:  Grit roller
2:  Left edge of the roll material

 

Straighten the roll material.

Align the right edge of the roll material so that it is parallel to the gradations
of the rulers (in two locations: one on the top and one on the bottom).

 

*:   Ruler gradation

 

Place the left and right pinch rollers over the grit
rollers on both edges of the roll material and the
middle pinch rollers over their corresponding grit
rollers.

Position the pinch rollers on the edges so that each one is 25 mm or more
inside of the respective left or right edge of the roll material.

 



*:  25 mm or more

 

Press [ENTER].

The pinch rollers lower to secure the roll material in place. 
Also, the cutting carriage moves to the origin and the width of the roll
material is shown on the display.

 

 

Handling Error Messages
If the following error message appears on the display, one of the pinch rollers is not in
the correct position.

Follow the procedure shown below to place the pinch rollers in the correct positions.



Procedure

Press [ENTER].

The cutting carriage moves to the right edge, and the following screen is
shown on the display.

 

Press [PINCH].

The pinch rollers rise up.

 

Place the pinch rollers in the correct positions.

Place them so that each is positioned over a grit roller. 
Position the pinch rollers on the edges so that each one is 25 mm or more
inside of the respective left or right edge of the roll material.

 

Press [ENTER].

When the pinch rollers are all placed in the correct positions and the loading
of the roll material is complete, the following screen appears.

 



 

Accurately Feeding Roll Material
Be sure to perform material feed if it is required. If you start cutting without checking
the material feed, correct cutting results may not be obtained if the material is not fed
correctly. In the worst case, this problem may cause an error or malfunction or damage
to the material.

Materials That Require Feeding

Roll material and long, flat material that is longer than 1.6 m (63 in.)

If the Material Comes Loose

Procedure

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.

 

Press the [ ] key, and then the [ ] key.

The screen shown in the figure below is displayed.



 

Press [ ].

 

Press [ ] or [ ] to set the value for the required
length of the material to cut.

It is a good idea to set a value that is about 0.2 m (7.9 in.) longer than the
required material length.

Press [ENTER].

The set length of the material moves out to the front, then is immediately
pulled back and taken up again.

Press the [MENU] key to return to the screen shown in the figure.

If the Material Comes Loose

If the material comes loose from the pinch rollers, press the [PAUSE] key to
stop operation. Then reload the material, starting over from the beginning.

Installing the Cutting Tool



CAUTION

Installing the Cutting Tool

Never touch the tip of the blade. 
Doing so may result in injury.

Notice：Use the blade which suit material

There is a risk of damage to blade when you cut unspecified sheet because of compatibility
between blade and sheet. Use the optimal blade for cutting to sheet material.

Items Required (Included Items)

Blade holder/pin Blade

Adjusting the Amount of Blade Extension

Adjust the amount of blade extension according to the material. 
You may not have to make this adjustment. Adjust the amount of blade extension
as required. 
The amount of blade extension can be adjusted by 0.5 mm for a full turn of the cap.

Adjusting the Cutting-in Amount

Installing the Cutting Tool



Procedure

Loosen the cutting carriage screw.

 

Install the cutting tool in the cutting carriage.

Normally, install it in the position shown in the figure (in the rear).
Install it in the front position when cutting perforated lines.

 

Tighten the cutting carriage screw.



 

Material Types and Blade Adjustment

It may be necessary to adjust the amount of blade extension for some types of
material, such as material with thin carrier paper. If you are not able to obtain
stable cutting results, changing the amount of blade extension can yield better
results. For more information, refer to the pages indicated below.

General Guide Regarding Cutting Conditions

Changing the Blade Force

Changing the Cutting Speed

Adjusting the Cutting-in Amount

 

Performing a Cutting Test



Performing a Cutting Test
To obtain high-quality cutting results, carry out a cutting test to check the cutting
quality for the material before you perform the actual cutting.

Procedure

Setting the Number of Cutting Tests to Perform

Check that the PEN FORCE slider is at the center
position (at "0" on the scale).

Press ［CUT CONFIG］ to display the following
screen.

Press ［ ］ to display the following screen.



Press [ ] or [ ] to set the number of cutting tests
to perform.

Cutting tests in three locations: Status of the finished product

Cutting test in one location: Status of the finished product

Press [ENTER] to select the setting.

You are returned to the following screen (in this example, three cutting tests
will be performed).

Press [ENTER].

The test pattern is cut. 

The position of the blade at the time the button is pressed is the cutting
test start position. 
You can use the cursor keys to set the position as desired.



When the cutting test finishes, the material is automatically fed to the
front.

Peel off circle 1.

Use the tweezers or a similar tool to peel off the cut shape, and then check
the cutting quality.

Circle 1

Tweezers

If Circle 1 Peels Off Alone → Step 8



*: Circle 1

If Other Shapes Also Peel Off/The Machine Cuts the Carrier
Paper → "Changing the Blade Force"

Peel off rectangle 2.

Use the tweezers or a similar tool to peel off the cut shape, and then check
the cutting quality.

Rectangle 2

If the Blade Leaves Faint Traces on the Material's Carrier
Paper → Setting the Origin

Faint lines remain here.



If the Traces Left by the Blade Are Indistinct/Too Deep →
"Changing the Blade Force"

 

Setting the Origin



Setting the Origin
The origin is set in order to determine the cutting position. 
Move the cutting carriage to a place where it does not overlap the location where
you made the cutting test.

Procedure

Press ［MENU］ to display the following screen.

Moving the Cutting Carriage at High Speed

Press [ ], [ ], [ ], and [ ] to move the cutting
carriage to the location you want to set as the
origin.

 

Press [ ] to move the material backward, and
ensure that the cutting test traces are in front of
the blade protector.

The blade moves over the blade protector. 
When the origin is set, the side behind the red line is set as the cutting range.

 

*: Blade protector



Hold down [ORIGIN] for one second or longer.

The screen flashes.

This completes all preparations for cutting.

Creating Cutting Data (1)



Creating Cutting Data (1)

(1) Start CutStudio
Use CutStudio cutting software to create cutting data.

If CutStudio is not installed, click here.

If you are using a Macintosh, click here.

Procedure

Start CutStudio.

Windows 10 and Windows 7

On the Start menu, click All Programs (or Programs), click Roland CutStudio, and
then click CutStudio.

Windows 8.1

At the lower left of the Start screen, click  to display the Apps screen. Click 
.

CutStudio starts.

http://startup.rolanddg.com/


 

(2) Set the Model

Procedure

From the File menu, click Cutting Setup.

The Cut Setting window appears.



Use Name under Printer to select the model name
of the cutting machine to use.

Creating Cutting Data (2)



Creating Cutting Data (2)

Set Material Size

Procedure

Click Change under Media Size.

Click Get from Machine.

The cuttable area is displayed.



If a Message Saying "The machine is not responding." Is
Displayed

Refer to "The Machine Doesn't Run," and check the machine and computer
settings.

Click OK.

Click OK in the Cut Setting window.



The cutting area is set.

The white area is the cutting area. Characters and shapes outside this
area will not be cut.

 

*1: Cutting area



*2: The origin set in
"Setting the Origin"
(the cutting start
position) corresponds
to the lower-left corner
of the screen in
CutStudio.

Entering Characters and Shapes



Entering Characters and Shapes

Enter Characters and Shapes

This example explains the procedure for entering the word "SALE" and creating a frame
to make it easy to peel off afterward.

Procedure

Click .

Click anywhere in the white area, and then type
"SALE."



Click , and then change the size of the
characters.

■ and ▼ appear around the characters. Drag the ■ and ▼ symbols around
the text box to change the size of the characters.

Select the object, and then click  in the menu bar. You can



configure advanced settings in the Properties palette.

From the Object menu, click Weed.

The Weed dialog box appears.

Select the Weed Border check box, and then click
OK.



A waste removal line is added around the characters. 
The character or shape to which the waste removal line has been added is
grouped together with the waste removal line. 
For details on waste removal lines, see the CutStudio help.

Click , and then move the characters with the
waste removal frame added.

Move the object to the bottom of the screen close to the origin.

Select the object that you want to move to the origin, and then click 
 in the menu bar to move this object to the origin.

Position Characters and Shapes at the Bottom of the Screen



When positioning characters and shapes in CutStudio, it is better to position
them starting from the bottom of the screen. This makes it possible to prevent
feeding more of the material than needed. 
The leading edge of the loaded material is the bottom edge of the cutting area in
the CutStudio screen. Therefore, positioning characters at the bottom of the
CutStudio screen means the characters will be cut close to the leading edge of
the material.

CutStudio screen

Actual cutting
position

Saving Cutting Data



Saving Cutting Data

Save Data

Procedure

Click .

The screen shown in the following figure is displayed.

Select a folder where you want to save the data.

Enter a file name, and then click Save. The data you have created is saved.

Important: The cutting area is not saved.

The cutting area you set in this procedure is not saved. The next time data is



loaded, the cutting area must be set again from the Cut Setting menu.

Performing Cutting



CAUTION

Performing Cutting

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Once the data has been prepared you are ready to start cutting.

If you are using a Macintosh, click here.

Procedure

Click .

Click OK.

Cutting data is sent from the computer, and then cutting starts.



If you want to change the cutting conditions, click Change, clear the Use
cutting conditions of machine check box, and then enter the values.

This completes the cutting procedure for the characters "SALE" and the
rectangle.

Removing the Material



To Cancel Cutting

Procedure

Press [PAUSE]

Hold down [ENTER] for one second or longer.

The data is canceled.

Removing the Material

 



Creating Cutting Data

* You must install Plug-in for Illustrator before proceeding.

Installing Plug-in for Illustrator

Procedure

Start Illustrator.

In Illustrator, click Extensions > Roland CutStudio
from the Window menu.

The "Roland CutStudio" palette appears.

for Macintosh User

http://startup.rolanddg.com/


 

Open a new document, and then set the artboard.

Set the document size to be the same as the cutting width displayed on the
machine. 
Set a length that is longer than the product that you want to create.

Enter "SALE."

After you enter the text, change the size of the characters, and then drag the
text to the bottom of the document.



Position characters and shapes in the lower-left corner of the
document.

It is better to position characters and shapes starting from the bottom of the
document. 
This makes it possible to prevent feeding more of the material than needed.

Illustrator screen

Actual cutting position



 

Select the Auto Update check box in the palette.

 

With "SALE" selected, click .

An outline is created.

 



Use Illustrator's rectangle tool to draw a frame
around "SALE."

Save the data.

 

Performing Cutting

 



Performing Cutting
Once the data has been prepared you are ready to start cutting.

Changing and Checking the Cut Settings

Procedure

On the palette, select Output All Lines, and then
click Update.

Check that all the contour lines that you wish to cut are shown on the
palette's preview screen.

for Macintosh User



On the palette, click .

The screen shown in the following figure is displayed.

Select the model name of the machine on hand,
and then click Cut.

Cutting starts.

If the model name is not displayed, see "The Machine Doesn't Run."

When cutting is finished, click Exit to close the
window.

To Cancel Cutting

 

Removing the Material

 



Configuring Cut Settings from a Computer

Procedure

Click  on the palette, and then click Preferences.

 

Select the Use cut settings check box, and then
click OK.

 

Click  on the palette, and then click Cut Settings.

Cutting Setup will not be displayed if you do not perform
steps 1 and 2.



 

When You Do Not Select the Use Machine Settings Check Box

Cutting is performed with the settings shown in the following figure (the Cut
Setup screen).

 

When You Select the Use Machine Settings Check Box



Cutting is performed with the machine settings.

Click OK.

To Cancel Cutting

Procedure

Press [PAUSE]

Hold down [ENTER] for one second or longer.

The data is canceled.



Removing the Material

 



Removing the Material
When cutting has finished, remove the material.

Procedure

Press [MENU] several times to display the screen
shown below.

Press [ENTER].

The cutting carriage returns to the home position.

Press [PINCH].

The pinch rollers rise up to release the material.



Remove the material by moving it through the rear
of the machine.

To Remove Only the Cut Area

Procedure

Press [ ] and [ ] to feed the material to the
location that you want to cut.

The material is cut off at the position shown in the figure.

 

*: Groove along which the separating knife
passes

Hold down [SHEET CUT] for one second or longer.

The cutting carriage moves to the left edge and then to the right edge in
order to cut the material.



After the material is cut, the cutting carriage returns to the new origin.



Improving the Finish

Optimizing the Cutting Quality for the Material

Performing a Cutting Test

Changing the Blade Force

Changing the Cutting Speed

Adjusting the Cutting-in Amount

 

Cutting Conditions

General Guide Regarding Cutting Conditions

 

Using a Variety of Materials

Using Various Types of Materials

Loading Flat Material

Using Various Material Widths (Loading Position of Material)

 

Minimizing Wasted Material

Using the Material with Minimal Waste

 



Changing the Blade Force
If the material was not cut correctly (for example, if the result of the cutting test was
that two shapes peeled off together), change the blade force.

Procedure

Check that the PEN FORCE slider is at the center
position (at "0" on the scale).

 

Press ［CUT CONFIG］ to display the following
screen.

 

Press [ ] to display the following screen.

 

Press ［ ］ to display the following screen.



 

Press [ ] and [ ] to change the blade force.

 

Press [ENTER] to select the setting.

 

Press [MENU] to return to the original screen.

 

Fine-tuning the Blade Force

After you set the blade force using the FORCE menu, you can further fine-
tune the blade force using the PEN FORCE slider. Use this operation when
you want to make the blade force slightly larger or smaller than the setting
made using the menu.

Adjustable range: ±Approximately 30 gf



* This value is intended only as a rough guide. The accuracy of this value is
not guaranteed.

Improving the Finish

 



Changing the Cutting Speed
If the material was not cut correctly (for example, if the result of the cutting test was
that two shapes peeled off together), reduce the cutting speed. 
When the cutting speed is fast and the material moves up and down during cutting, an
excessive load will be applied to the material. In this situation as well, reduce the
cutting speed.

Procedure

Press ［CUT CONFIG］ to display the following
screen.

 

Press ［ ］ several times to display the following
screen.

 

Press ［ ］ to display the following screen.

 

Press [ ] and [ ] to change the cutting speed.



 

Press [ENTER] to select the setting.

 

Press [MENU] to return to the original screen.

 

Improving the Finish

 



Adjusting the Cutting-in Amount
When you want to perform accurate adjustment of the cutting-in amount, such as
when cutting material with thin carrier paper, you can obtain good results by adjusting
the amount of blade extension. 
Turn the cap portion of the blade holder to adjust the amount of blade extension.

An adjustment of 0.5 millimeters can be
made by rotating the cap one full turn.

 

General Guide for Amount of Blade Extension

Use the following formula as a rough guide for setting the amount of blade
extension.

Amount of blade extension = thickness of material + (thickness of
carrier paper/2)

1: Amount of blade extension
(which approximately equals
the cutting-in amount)
2: Material portion
3: Carrier paper portion
4: 1/2 of the carrier paper



Improving the Finish

 



General Guide Regarding Cutting
Conditions

A general guide for cutting conditions and the service life of the blade for different
combinations of materials and blades is given below. 
Note that optimal cutting is not necessarily obtained simply by conforming to the
conditions below. Perform a cutting test in advance to adjust the conditions. 
(For instructions on performing a cutting test, refer to "Performing a Cutting Test.")

Notice：Use the blade which suit material

There is a risk of damage to blade when you cut unspecified sheet because of compatibility
between blade and sheet. Use the optimal blade for cutting to sheet material.

Blade Material Cutting force
(gf)

Cutting
speed

(cm/sec)

Amount of
blade offset

(mm)

Pinching
force

ZEC-U5032

General signage vinyl 30 to 100

30 or less 0.25

2 to 6

General inkjet vinyl 50 to 100 3 to 6

Iron-on print vinyl 50 to 100 2 to 6

ZEC-U5025
General signage vinyl 40 to 100 30 or less

0.25
2 to 6

Fluorescent vinyl 120 to 200 10 or less 4 to 8

ZEC-U5010 Glass (car) film 80 to 120 30 or less 0.50 1 to 6

ZEC-U1715 Sandblast 100 to 150 5 or less 0.25 7 to 10

ZEC-U3050
Coated board (thin) 200 to 350

5 or less 0.50
6 to 8

Reflective vinyl 350 to 450 6 to 10

ZEC-U3075
Coated board (thick) 250 to 400

5 or less 0.75 7 to 10
Reflective vinyl 350 to 450

* The faster the cutting speed, the worse the image quality, so you have to adjust the
speed to match the required image quality.

If uncut areas remain even when the blade force is increased by more
than 50 to 60 gf, the blade has most likely reached the end of its service
life.

Replace it with a new blade.

Consumable Items



If the desired cutting results are not obtained (for example, if uncut areas remain) even
after the blade is replaced, refer to "Uncut Areas Remain or Cut Edges Are Not Clean."

 

Improving the Finish

 



CAUTION

Using Various Types of Materials

Using Roll Material

Never load media that weighs over 40 kg (88.19
lb.). 
The machine may fail to withstand the weight, causing
the machine to tip over or the material to fall.

Loading Roll Material

 

Using Flat Material

If flat material is used, it must be at least 60 mm longer than the vertical size of the
cutting data. This is the length required for the pinch rollers to feed out the material
to the front and rear.

Refer to the figure below and ensure that there are sufficient margins at the front
and rear of the material.

 

1: 30 mm or more
2: 30 mm or more
3: Pinch roller
4: Material-feed direction

 

Loading Flat Material



Using Material with Perforations for Sprocket Feed

Sprocket-fed material has perforations along each edge. If the pinch rollers are
positioned over the perforations, the material cannot be fed correctly. 
Load the material as shown in the figure.

Improving the Finish

 



Loading Flat Material
This example uses flat, A4-size material to explain how to load the material.

If using roll material or other material, refer to "Loading Roll Material" and load the
material.

Procedure

If the pinch rollers have lowered, press [PINCH].

Check that the pinch rollers have risen.

Place the right edge of the material over the grit
roller (on the right edge).

For A4-size material, do not use the middle pinch rollers.

Using Narrow Material/Preventing Marking Made by the Middle Pinch Rollers

 

1: Grit roller
2: Right edge of the material



Slide the material to place its left edge over the
grit roller.

At this point, check that the right edge of the material remains over the grit
roller on the right edge.

 

1: Grit roller
2: Left edge of the material

Straighten the material.

Align the right edge of the material so that it is parallel to the gradations of
the rulers (in two locations: one on the top and one on the bottom).

*: Ruler gradation

Place the left and right pinch rollers over the grit
rollers on both edges of the material.

Position the pinch rollers on the edges so that each one is 25 mm or more
inside of the respective left or right edge of the material.



*: 25 mm or more

The middle pinch rollers are not used with A4-size material. However, when you
are using these rollers to load material, place them over their corresponding grit
rollers.

Select [PIECE] for the material type.

Using Various Types of Materials

Press [ENTER].

The pinch rolls lower and the carriage and material move. 
When the movement is finished, the cuttable width and length are displayed.

If the condition of the material is as described below, stretch
or flatten it before use.

The material is curled upward.
The leading edge of the material is bent or creased.



Improving the Finish

 



Using Various Material Widths
(Loading Position of Material)

Loading Position of Material

Set the pinch rollers so they are inside the grit patterns.

Number Description

1

Use the right pinch roller within this range. 
When the left edge of the material is placed on one of the grit rollers from 2 to 9, load the
material so that its right edge is within the range of this wide grit roller. 
Load the material in this manner, and then slide the right pinch roller to a position
approximately 10 mm inside the right edge of the material. For details on how to load the
material, see "Loading Roll Material" or "Loading Flat Material."

2 The position of the left pinch roller for material having widths of 156 mm and 306 mm.
3 The position of the left pinch roller for material having a width of 457 mm.
4 The position of the left pinch roller for material having a width of 610 mm.
5 The position of the left pinch roller for material having a width of 762 mm.
6 The position of the left pinch roller for material having widths of 914 mm and 1,067 mm.
7 The position of the left pinch roller for material having a width of 1,220 mm.
8 The position of the left pinch roller for material having a width of 1,372 mm.
9 The position of the left pinch roller for material having widths of 1,524 mm and 1,626 mm.

Pinch Roller/Grit Pattern



1: Grit pattern
2: Pinch roller

 

Improving the Finish

 



Using the Material with Minimal
Waste

Setting the Origin
You can use [ORIGIN] to freely set the position of the origin. You can use the
material with minimal waste by setting the origin to an uncut position on the
material.

Procedure

Load the material in the machine, and make it
ready for cutting (setup condition).

 

Press [ ], [ ], [ ], and [ ] to move the cutting
carriage to the position you want to cut.

 

Align the center of the blade with the position you
wish to make the origin.



 

Hold down [ORIGIN] for one second or longer.

[ORIGIN SET] flashes on the display.

When the setting is complete, the following screen appears.

 

Send the cutting data from the computer.

Cutting is performed using the specified origin.

 

Improving the Finish

 



Maintenance/Replacement

Cleaning

Cleaning

Replacing the Blade and the Separating Knife

Replacing the Blade and the Separating Knife

Consumable Items

Consumable Items



CAUTION

CAUTION

Cleaning
Cleaning is important in order to ensure clean cutting. Clean the machine
periodically.

Cleaning the Blade Holder Cap

Be sure to perform operations as specified by the
instructions, and never touch any area not specified
in the instructions. 
Sudden movement of the machine may cause injury or
burns.

Never use a solvent such as gasoline, alcohol, or
thinner to perform cleaning. 
Doing so may cause fire.

 

Cleaning the Machine

Items Required

Cloth soaked in water and thoroughly wrung out

Switch off the power before cleaning the machine.

 



1: Grit rollers
Periodically wipe away any grime.

2: Display:
Wipe the display clean with a dry cloth.

3: Pinch rollers
Remove any buildup of media and other material using a brush. Never use a
metal brush.

 

Cleaning the Blade Holder Cap
If there is a buildup of pieces of material or dust inside the cap, loosen the cap,
remove it, and then remove any foreign matter. If pieces of material or dust build
up inside the blade holder cap, the blade will stop turning smoothly and will no
longer cut cleanly.

1: Cap
2: Loosen

 

Consumable Items



CAUTION

Replacing the Blade and the
Separating Knife

If the blade becomes dull, replace it with a replacement blade.

Consumable Items

Be sure to perform operations as specified by the
instructions, and never touch any area not specified in
the instructions. 
Sudden movement of the machine may cause injury or burns.

Remove the material before performing the replacement.

Replacing the Blade

Procedure

Loosen the cutting carriage screw, and then remove
the cutting tool from the carriage.



CAUTION Never touch the tip of the blade. 
Doing so may result in injury.

Remove the old blade.



1: Press this pin.
2: Old blade

Install a new blade.

1: New blade
2: Cutting tool with the new blade installed.

Install the cutting tool.

Installing the Cutting Tool

Replacing the Separating Knife



Procedure

Remove the separating knife. 
(1) Loosen the screw until it slips out. 
(2) Grasp the screw portion, and then slowly pull it
out in the direction of the arrow.

When doing this, do not pull it back toward you.

Install a new knife.

The knife is secured in place by the magnet.

1: Magnet
2: Positioning groove

Slowly insert the knife into the groove.

Tighten the screw.

Take care to ensure that the knife does not slip out of position at this time.





Consumable Items

Purchasing Consumable Items

To purchase consumable items, visit the Roland DG Corp. website
(http://www.rolanddg.com/) or contact your authorized Roland DG Corp. dealer.

Blade

Blade

In the cases below, the blade has reached the end of its service life. Replace it
with a new item. 
The tip of the blade is broken. 
Uncut areas remain even though the blade force has been increased by 50 to 60
gf. 
Cuts are not as clean as they used to be. 
The material starts to curl up from the carrier paper when cutting detailed areas
or corners.

The tip of a blade that has been used for a long time or has been used to cut
hard material may wear away. A blade that has worn in this manner will no
longer cut cleanly, so replace it with a new one.

Replacing the Blade and the Separating Knife

Blade Holder

http://www.rolanddg.co.jp/


Blade holder

After the tip of the blade has been adjusted, the cap of the blade holder rubs
against the material when cutting, causing the end of the cap to gradually wear
away. As the cap becomes increasingly worn it becomes impossible to adjust the
tip of the blade correctly, and clean cutting is no longer possible. When this
happens, replace the blade holder with a new one. 
When a blade holder has been used for a long time, the bearing that supports
the blade deteriorates, making it more difficult for the blade to turn. If you
continue to use a blade holder that has deteriorated in this fashion, the machine
will not cut cleanly because the tip of the blade will not turn smoothly. If corners
or curved sections are not cut cleanly or cuts start looking like perforated lines,
or if similar problems occur, refer to "Cleaning the Blade Holder Cap" and clean
the blade holder cap. If this fails to resolve the problem, replace the blade holder
with a new one.

Blade Protector

If cutting is performed when the amount of blade extension or the blade force is
not adjusted appropriately, the tip of the blade may pierce the material's carrier
paper and scratch the blade protector. If cutting is performed when the blade
protector is scratched, it will not be possible to cut cleanly. 
If the surface of the blade protector is deformed due to scratching or similar
damage, the blade protector must be replaced. Contact your authorized Roland
DG Corp. dealer.

 



Troubleshooting

The Machine Doesn't Run

The Machine Doesn't Run

The Material Is Jammed

Jammed Material Cannot Be Removed

Flat Material Cannot Be Set Up Using "PIECE" (Length Is Not
Displayed)

Flat Material Cannot Be Set Up Using "PIECE" (Length Is Not Displayed)

Creating or Importing Data

Changing the Darkness of an Aligned Image

Illustrator Data Cannot Be Imported

Sample Data Cannot Be Found

The Material Slips Away from the Pinch Rollers during Cutting

The Material Slips Away from the Pinch Rollers during Cutting

Crop Marks Cannot Be Read

Crop Marks Cannot Be Read

Cutting Results Are Not Clean

The Results of Cutting Are Displaced When Using the Printing and Cutting Function

Uncut Areas Remain or Cut Edges Are Not Clean

The Machine Cuts the Carrier Paper

The Machine Cuts the Same Area Twice



Installing and Uninstalling Software

The Driver Cannot Be Installed (Windows 10)

The Driver Cannot Be Installed (Windows 8.1)

The Driver Cannot Be Installed (Windows 7)

Uninstalling the Driver (Windows 10)

Uninstalling the Driver (Windows 8.1)

Uninstalling the Driver (Windows 7)

Connecting Two or More Instances of This Machine to a Single Computer (Connecting
Multiple Units with a USB Cable)

The Driver Is Displayed as "Unspecified" after Installation

Frequently Asked Questions

Moving a Saved Symbol to a New Computer

Consumable Items

Supported Versions of Illustrator

Supported Versions of CorelDRAW

Error Message List

 



The Machine Doesn't Run

Are cables connected?

Check that the power cord and the USB cable/network cable to the computer are
connected correctly.

Is the power switched off?

Turn on the machine power.

Is the machine ready to receive cutting data?

If the display shows the following screen, cutting cannot be performed even when
data is sent. 
Select the loaded material, press the [ENTER] key, and then set the machine so it is
ready to receive cutting data.

Are the software application settings incorrect?

Select the appropriate driver for the machine. 
For the selection procedure, refer to the manual for the application software.

 

If the Machine Does Not Run Even after You Have Checked the Above
Points

Perform a self test. If the self test cannot be executed, the machine may have
malfunctioned. 
Contact your authorized Roland DG Corp. dealer.

Checking the Machine Status (Self Test)



Flat Material Cannot Be Set Up
Using "PIECE" (Length Is Not
Displayed)

Is the material 1.6 m or longer?

If flat material 1.6 m or longer is set up using "PIECE," the machine recognizes it as
a roll.

Using Various Types of Materials

 



Changing the Darkness of an
Aligned Image

It is possible to change the darkness of an image imported into CutStudio.

Procedure

From the File menu, click Preferences.

On the General tab, enter a value in the Image
Darkness box.

Setting range: 1 to 100%



Click OK.

 



Illustrator Data Cannot Be
Imported

Is the data saved in Illustrator 8.0 or EPS 8.0 format?

Illustrator 8.0 and EPS 8.0 are the Illustrator file formats that can be imported into
CutStudio. If using a higher version, save files as a lower version before importing.

File Formats That Can Be Imported into CutStudio

 



Sample Data Cannot Be Found

Location of Sample Data Folder
Open the Sample.bmp file found in the CutStudio installation folder (usually located
in the CutStudio folder under Program Files on the C drive).

Is the computer not set to show hidden folders?

Sample data may not be displayed in some cases depending on the computer
settings. If sample data is not displayed, follow the procedure shown below and
recheck the location of the sample data folder.

Windows 10 and Windows 8.1

Procedure

Click Explorer.

Click the folder in the lower-left corner of the desktop.

The screen shown in the following figure is displayed.



Click the View tab.

 

Select the Hidden items check box.

 



Windows 7

Procedure

From the Start menu, click Computer.

 

In the Organize menu, click Folder and search
options.

The screen shown in the following figure is displayed.



 

Click the View tab, and then select the Show
hidden files, folders, and drives option.

 



Click OK.

 



The Material Slips Away from the
Pinch Rollers during Cutting

Is the material loaded in parallel with the gradations of the ruler?

If the front edge of the material is cut at an angle, trim off an excess portion so that
the front edge is parallel with the gradations of the ruler, and then load the material.

Using Various Material Widths

 

Is the material making contact with some obstacle during cutting?

Make sure that the left and right edges of the material do not make contact with the
inner surfaces of the machine during cutting. 
Such contact not only damages the material but also hinders normal material feed
and causes the material to slip out of position.

 

Was the material feed checked before cutting (for roll material)?

If you start cutting without checking the material feed, correct cutting results may
not be obtained if the material is not fed correctly. In the worst case, this problem
may cause an error or malfunction or damage to the material.

Loading Roll Material

 

Is the machine exposed to direct sunlight or strong indoor lighting?

Move the machine to a location where it is not exposed to direct sunlight or indoor
lighting.

 



Crop Marks Cannot Be Read
When the machine cannot read crop marks, it displays an error message and pauses
operation. 
If this happens, press any key on the operation panel. Remove the material, check the
following items, and then reload the material.

"CROPMARK ERR" or "SET TO <TOOL MODE>" Is Displayed

Is the material loaded correctly?

Refer to "Using Various Types of Materials" and load the material in the correct
position.

Are you using material that is not white or is glossy?

Crop marks cannot be detected if decorations or colors are on the material. 
Crop marks also may not be detected on glossy material even if it is white.

Materials That Can Be Used for Printing and Cutting

Does the material have creases or wrinkles?

Crop marks may not be read if the material has creases or wrinkles. Stretch the
creases or wrinkles out and load the material again. 
If the crop marks still fail to be read, prepare new material without creases or
wrinkles and redo the operation from printing the data.

 

Are the crop marks blurred or are they in a color other than black?

Set the color of crop marks to black, specify 100% density, and then print the data
again.

Crop Marks



 

Are the size and shape of crop marks correct?

Make the crop marks perfect circles 10 mm (0.39 in.) in diameter. 
The machine can only detect crop marks in the prescribed shape.

Crop Marks

 

Are the crop marks at the correct positions?

Refer to "Setting the Margins and the Distance between Crop Marks" and place the
crop marks at the correct positions.

 

Is the [ROTATE] menu set to [90deg]?

Be sure to set the [ROTATE] menu to [0deg] when using crop marks. 
Crop marks cannot be read if this is set to [90deg].

Setting the Direction of the Coordinate Axis for Cutting <ROTATE>

 

Is the machine exposed to direct sunlight or strong indoor lighting?

If the cutting carriage sensor is exposed to direct sunlight or indoor lighting, crop
marks may not be detected. Move the machine to a location where it is not exposed
to direct sunlight or indoor lighting.

If the Issue Is Not Resolved Even after Taking the Above Steps

Perform alignment in Tool Mode.

Cutting in Tool Mode (1)

 

 



"LENGTH NG," "WIDTH NG," or "ANGLE TOO BIG" Is
Displayed

Is the material loaded at an angle? Are the printing results crooked?

Crop marks cannot be detected in the following cases:

The left and right crop marks are slanted by 5 degrees or more with respect to the
moving direction of the carriage.
The left and right crop marks are offset by 20 mm or more in the material-feed
direction.

Do the distances between crop marks specified by the software match
those specified on the machine? (Manual mode)

On the machine, correctly set the distance specified by the software.

 

Are the crop marks at the correct positions?

If the angle formed by the two lines connecting the centers of the crop marks is not
90 degrees, the crop marks cannot be read. Crop marks cannot be read if the
distance between crop marks in the material-feed direction is 500 mm (19.69 in.) or
more.

 

Is the printing expanded or reduced?

If the size is expanded or reduced during printing, the crop marks cannot be read
during cutting. Print the data by specifying 100% for the magnification.

 



The Results of Cutting Are
Displaced When Using the Printing
and Cutting Function

Is a thick material being used?

When using thick material, set [Cutting Quality] to [HEAVY].

Setting Cutting Quality <QUALITY>

 

When using roll material, was the amount of material to be cut pulled
out before performing cutting?

If cutting is performed without pulling out the material, the material may slip or a
motor error may stop the operation

Loading Roll Material

 

Fine-tuning the Printing Position

Adjusting the Printing Position

 

Fine-tuning the Cutting Position

Adjusting the Cutting Position

 

 



Uncut Areas Remain or Cut Edges
Are Not Clean

Are the blade and blade holder securely installed?

Make sure the screws are tightened securely so that they do not come loose during
cutting.

Installing the Cutting Tool

 

Is the tip of the blade broken?

If it is, replace the blade with a new one.

Consumable Items (Blade)

 

Is there any buildup of dust or material adhesive on the tip of the
blade?

Remove and clean the blade.

 

Is there any buildup of pieces of material or dust inside the blade
holder?

Take off the tip of the blade holder and remove any pieces of material or dust inside.

Cleaning the Blade Holder Cap

Is a thick material being used?

When using thick material, set [Cutting Quality] to [HEAVY].



Setting Cutting Quality <QUALITY>

Is the blade force appropriate?

Carry out cutting tests and adjust the blade force until cutting can be performed
adequately.

Performing a Cutting Test

 

Is the amount of blade offset appropriate?

If the setting for the amount of blade offset is not correct for the blade, corners may
be rounded or have horns.

Setting the Amount of Offset for the Tip of the Blade <OFFSET>

Are the blade force and cutting speed appropriate?

Carry out cutting tests and adjust the settings until cutting can be performed
adequately.

Performing a Cutting Test

 

When using roll material, was the amount of material to be cut pulled
out before performing cutting?

If cutting is performed without pulling out the material, the material may slip or a
motor error may stop the operation

Loading Roll Material

 

Is the smoothing function turned off?



Cutting Detailed Characters and Complex Shapes

 

Is the blade protector damaged or deformed?

If the blade protector is damaged, the material may not be cut correctly even if the
machine's settings and the installation of the blade and blade holder are all correct. 
If this happens, contact your authorized Roland DG Corp. dealer.

Consumable Items (Blade Protector)

 



The Machine Cuts the Carrier
Paper

Are the blade tip adjustment and blade force appropriate for the
material being cut?

Perform a cutting test and adjust the blade tip and blade force appropriately.

Performing a Cutting Test

General Guide Regarding Cutting Conditions

Adjusting the Cutting-in Amount

 



The Machine Cuts the Same Area
Twice

Is Overlap Cutting set to 0 in CutStudio?

If Overlap Cutting is set to any number other than 0 on the Cut screen, the number
is added to the number of cuts.

Is the machine's [OVERLAP] setting a number from 1 to 10?

Set the machine's [OVERLAP] setting to [OFF].

Cutting in the Same Position Repetitively <OVERLAP>

Are there overlapping lines?

The same data may have been copied, resulting in overlapping lines. Check the
data.

 



The Driver Cannot Be Installed
(Windows 10)

If you have canceled installation or if the installation wizard does not appear when the
USB cable is connected, follow the procedure shown below.

Procedure

Connect the machine to the computer with the USB
cable and turn on the machine.

 

If a message saying "Found new hardware"
appears, click Close.

Disconnect the USB cable from every printer except the machine.

 

On the Start menu, click Settings.

 

Click Devices, and then click Printers & scanners
on the following screen.

 

Click Device Manager. If a User Account Control
window appears, click Allow.

Device Manager appears.

 



From the View menu, click Show hidden devices.

 

Search the list for Printers or Other devices, and
then double-click it.

The name of your machine or Unknown device appears below the selected
item. Click the name to select it.

 

From the Action menu, click Uninstall.

 

On the Confirm Device Uninstall window, click OK.
Close Device Manager.

 

Disconnect the USB cable from the computer, and
then restart Windows.

 

Follow the procedure in "Uninstalling the Driver
(Windows 10)" and uninstall the driver.

 

Follow the procedure in "Installing the Driver for
Windows" and reinstall the driver from the
beginning.



http://startup.rolanddg.com/

 

http://startup.rolanddg.com/


The Driver Cannot Be Installed
(Windows 8.1)

If you have canceled installation or if the installation wizard does not appear when the
USB cable is connected, follow the procedure shown below.

Procedure

Connect the machine to the computer with the USB
cable and turn on the machine.

 

If a message saying "Found new hardware"
appears, click Close.

Disconnect the USB cable from every printer except the machine.

 

Click Desktop.

 

Move the mouse pointer to the lower-right corner
of the screen to display the Charms bar, and then
click Settings.

 

Click PC info.

 



Click Device Manager. If a User Account Control
window appears, click Allow.

Device Manager appears.

 

From the View menu, click Show hidden devices.

 

Search the list for Printers or Other devices, and
then double-click it.

The name of your machine or Unknown device appears below the selected
item. Click the name to select it.

 

From the Action menu, click Uninstall.

 

On the Confirm Device Uninstall window, click OK.
Close Device Manager.

 

Disconnect the USB cable from the computer, and
then restart Windows.

 

Follow the procedure in "Uninstalling the Driver
(Windows 8.1)" and uninstall the driver.

 



Follow the procedure in "Installing the Driver for
Windows" and reinstall the driver from the
beginning.

http://startup.rolanddg.com/

 

http://startup.rolanddg.com/


The Driver Cannot Be Installed
(Windows 7)

If you have canceled installation or if the installation wizard does not appear when the
USB cable is connected, follow the procedure shown below.

Procedure

Connect the machine to the computer with the USB
cable and turn on the machine.

If a message saying "Found new hardware"
appears, click Close.

Disconnect the USB cable from every printer except the machine.

Click the Start menu, and then right-click
Computer. Click Properties.

 

Click Device Manager. If a User Account Control
window appears, click Allow.

Device Manager appears.

 

From the View menu, click Show hidden devices.

 

Search the list for Printers or Other devices, and



then double-click it. The name of your machine or
Unknown device appears below the selected item.
Click the name to select it.

 

From the Action menu, click Uninstall.

 

On the Confirm Device Uninstall window, select the
Delete the driver software for this device check
box, and then click OK. Close Device Manager.

The name of your machine or Unknown device appears below the selected
item. Click the name to select it.

 

Disconnect the USB cable from the computer, and
then restart Windows.

 

Follow the procedure in "Uninstalling the Driver
(Windows 7)" and uninstall the driver.

 

Follow the procedure in "Installing the Driver for
Windows" and reinstall the driver from the
beginning.

http://startup.rolanddg.com/

 

http://startup.rolanddg.com/


Uninstalling the Driver
(Windows 10)

To uninstall the driver, follow the procedure below.

Procedure

Switch off the machine, and then disconnect the
connector cable between the computer and the
machine.

 

Log on to Windows as the computer's
administrator.

 

Right-click the Start menu, click Control Panel, and
then click Uninstall a program.

 

Select the driver of the machine you want to delete
by clicking it, and then click Uninstall.

 

A deletion confirmation message appears. Click
Yes.

 



Click Start to display the Start menu.

 

Open File Explorer, and then open the drive and
folder containing the driver.*

 

Double-click SETUP64.EXE (64-bit version) or
SETUP.EXE (32-bit version).

 

If a User Account Control window appears, click
Yes.

The setup program for the driver starts.

 

Click Uninstall. Select the machine you want to
delete, and then click Start.

 

If a window prompting you to restart the computer
appears, click Yes.

The uninstall procedure is complete when the computer finishes restarting.

 

* Download the driver for the machine you want to delete from the Roland DG
Corp. website (http://www.rolanddg.com/), and then select a folder to extract
the files into.

 

http://www.rolanddg.co.jp/


Installation Procedure

http://startup.rolanddg.com/


Uninstalling the Driver
(Windows 8.1)

To uninstall the driver, follow the procedure below.

Procedure

Switch off the machine, and then disconnect the
connector cable between the computer and the
machine.

 

Start Windows.

 

Click Desktop.

 

Move the mouse pointer to the lower-right corner
of the screen to display the Charms bar, and then
click Settings.

 

Click Control Panel, and then click Uninstall a
program.

 

Select the driver of the machine you want to delete



by clicking it, and then click Uninstall.

 

A deletion confirmation message appears. Click
Yes.

 

From the Start menu, click Desktop.

 

Open File Explorer, and then open the drive and
folder containing the driver.*

 

Double-click SETUP64.EXE (64-bit version) or
SETUP.EXE (32-bit version).

 

If a User Account Control window appears, click
Allow.

The setup program for the driver starts.

 

Click Uninstall. Select the machine you want to
delete, and then click Start.

 

If you need to restart the computer, a window



prompting you to do so is displayed. Click Yes.

 

After the computer has restarted, open Control
Panel and click View devices and printers.

 

If you can see the icon of the machine to delete,
right-click it, and then click Remove device.

 

* Download the driver for the machine you want to delete from the Roland DG
Corp. website (http://www.rolanddg.com/), and then select a folder to extract
the files into.

 

Installation Procedure

http://www.rolanddg.co.jp/
http://startup.rolanddg.com/


Uninstalling the Driver
(Windows 7)

To uninstall the driver, follow the procedure below.

Procedure

Switch off the machine, and then disconnect the
connector cable between the computer and the
machine.

 

Log on to Windows as the computer's
administrator.

 

From the Start menu, click Control Panel, and then
click Uninstall a program.

Select the driver of the machine you want to delete
by clicking it, and then click Uninstall.

 

A deletion confirmation message appears. Click
Yes.

 

From the Start menu, click All Programs,



Accessories, Run, and then click Browse.

 

Select the name of the drive or folder where the
driver is stored.*

 

Double-click SETUP64.EXE (64-bit version) or
SETUP.EXE (32-bit version).

 

If a User Account Control window appears, click
Allow.

The setup program for the driver starts.

 

Click Uninstall. Select the machine you want to
delete, and then click Start.

 

If a window prompting you to restart the computer
appears, click Yes.

The uninstall procedure is complete when the computer finishes restarting.

 

* Download the driver for the machine you want to delete from the Roland DG
Corp. website (http://www.rolanddg.com/), and then select a folder to extract
the files into.

 

http://www.rolanddg.co.jp/


Installation Procedure

http://startup.rolanddg.com/


Connecting Two or More Instances of
This Machine to a Single Computer
(Connecting Multiple Units with a USB
Cable)

When connecting multiple instances of this machine to a single computer with a USB cable,
you must change the USB number of each machine so that the computer can distinguish
between output destinations. The machine's default setting is "A." When connecting two or
more machines, the second machine and every machine thereafter must be configured with
a setting other than "A" so that the machine can distinguish the output destination of the
data.

 

 

(1) Change the Name of the Second Cutting Machine
Follow the procedure below to connect a second machine. The same procedure can be used to



connect a third unit and any subsequent units.

Procedure

* Do not connect the USB cable at this stage.

Turn off the power of the machine.

 

While holding down [PINCH], switch on the power
switch.

The screen shown in the following figure is displayed.

 

Press [ ] and [ ] to select a setting other than "A."

It is possible to select a value from "B" to "E." In this example, "B" is selected.

 

Press [ENTER].

The screen shown in the following figure is displayed.

 

Turn the power off and then on again.



The screen shown in the following figure is displayed. Check that the letter you set in
step 3 is displayed.

 

(2) Connect and Change the Computer's Printer Settings

Procedure

Connect the machine to the computer using the USB
cable.

The driver is installed.

 

Open Devices and Printers.

Roland GR-640 (Copy 1) (or 1 Copy) is created. 
(Hereinafter, this is referred to as "Copy 1.")



Windows 10

Right-click the Start menu, click Control Panel, click Hardware and Sound, and then
click Devices and Printers.

Windows 8.1

From the Start screen, click Apps, and then click Control Panel. Click Hardware and
Sound, and then click Devices and Printers.

Windows 7

From the Start menu, select Devices and Printers.

 

Right-click Roland GR-640 (Copy 1), and then select
Printer properties.

 

Change Roland GR-640 (Copy 1) to Roland GR-640 (B).



 

Click OK.

 

(3) Check That the Second Cutting Machine Has Been Installed

Procedure

Start CutStudio.

 

From the File menu, click Cutting Setup.

 

Click the Printer Name.

Check that GS-640 (B) is displayed. 
If the screen looks similar to the one displayed in the figure below, the second
machine is connected correctly.



 

 



The Driver Is Displayed as
"Unspecified" after Installation

If the driver was not installed correctly, it may be displayed as "Unspecified" in some
cases. Try the installation method described at the link below.

The Driver is Displayed as "Unspecified"

 

URLs contained in this manual are subject to change without notice. If a link
appears to be broken, contact your authorized Roland DG Corp. dealer.

 

http://startup.rolanddg.com/CAMM-1/Share/EN/SH_EN_ON_DrvUnid.html


Moving a Saved Symbol to a New
Computer

For instructions on how to save symbols, check the CutStudio Help.

Procedure

Copy the Symbol folder from the path below.
Store the folder in a desired location or move it.

C:¥ProgramData¥Roland DG Corporation¥CutStudio
¥Symbol

 

If the Folder Is Not Displayed

In "Sample Data Cannot Be Found," configure the settings for displaying
hidden folders.

 

Copy the Symbol folder to a new computer.

Copy the folder to the same location on the new computer. 
If the folder is not displayed on the new computer, adjust the settings to
display hidden folders.

 



Installing Plug-in for Illustrator

Installation Procedure
Install from the following link.
http://startup.rolanddg.com/

 

Supported Versions
For information regarding the latest supported versions, visit the Roland DG Corp.
website (http://www.rolanddg.com/).

 

http://startup.rolanddg.com/
http://www.rolanddg.co.jp/


Installing Plug-in for CorelDRAW

Installation Procedure
Install from the following link.
http://startup.rolanddg.com/

 

Supported Versions
For information regarding the latest supported versions, visit the Roland DG Corp.
website (http://www.rolanddg.com/).

 

http://startup.rolanddg.com/
http://www.rolanddg.co.jp/


Index Solution Cause

Press any key to cancel setup and clear
the error message. Move the pinch
rollers to the correct positions and
reload the material.

* Note: If the message appears even if
the pinch rollers are moved to the
correct positions, the machine may be
exposed to direct sunlight or intense
indoor lighting. Turn off the power, and
then move the machine to a location
where it is not exposed to direct
sunlight or intense lighting. 
After moving the machine, turn on the
power.

Pinch rollers are at positions where the
material cannot be pinched.

Turn off the power, and then remove
any dust and other foreign materials
from the area around the cutting
carriage. After performing this
operation, turn on the power.

It is not possible to adjust the height of
the cutting carriage.

Press any key to clear the error
message. Reload the material.

Crop mark 2 or 3 is slanted by 5
degrees or more.

Press any key to clear the error
message. Reload the material.

Crop mark 3 is offset by 20 mm or
more in the material movement
direction.

Press any key to clear the error
message. Reload the material or change
the position of crop mark 2.

Crop mark 2 is offset by 20 mm or
more in the carriage direction.

First, delete the data stored in the
machine.

Prepare the Data for Recutting

Next, decrease the size of the data sent
from the computer and resend it. Then
carry out a REPLOT.

Cutting the Same Object Repetitively

The amount of data stored in the
machine is too large and REPLOT
cannot be executed.

Press any key to clear the error
message. Review the data sent from
the computer, and then send the
correct data.

Data that the machine is not able to
interpret was sent.

The number of parameters differs from
the permissible number.

The value of the specified parameter
was outside the permissible range.

A heavy load was placed on the motor,
and the operation stopped.

Error Message List



Turn off the power, turn on the power,
and then load the material again.

If jammed material is caught and
impedes the initial operation when you
turn the power on, perform the
following operations. 
1. Turn the power off.
2. Move the cutting carriage to the right
edge of the machine by hand.
3. Turn the power on (the pinch rollers
automatically rise).
4. Remove the jammed material.

• Cutting was performed when thick
material was loaded.
• The material was pulled off suddenly
from the roll without feeding out the
material before cutting.
• An overload was placed on the
machine due to a material jam or
similar cause.

When cutting roll material, pull out the
length of material to be cut from the
roll. Perform a test feed before cutting.
When doing so, set the [AREA] value in
the display menu so that it is around 20
cm longer than the length of the cutting
data.

Loading Roll Material

• When cutting thick material, set the
quality setting to [HEAVY].

Setting Cutting Quality <QUALITY>

Turn off the power, and then move the
machine to a location where it is not
exposed to direct sunlight or intense
indoor lighting. Then, turn on the
power.

The machine is exposed to direct
sunlight or strong indoor lighting and
was not able to detect the origin
immediately after the power was
switched on.

Press any key to clear the error
message. Change the machine's
settings to Tool Mode, and then resend
the data. When doing so, use four crop
marks. When the machine is in Tool
Mode, it is not possible to cut using
three crop marks. 
If you want to use three crop marks,
leave the machine in Sensor Mode and
change the shape and color of the crop
marks or the color and glossiness of the
material.

Crop Marks/Tool Marks

Crop Marks Cannot Be Read

Cutting in Tool Mode (1)

Crop marks could not be read in Sensor
Mode.

Press any key to cancel setup and clear
the error message. Load the material
correctly, and then make it ready for
cutting (setup condition).

Loading Position of Material

An attempt was made to ready the
machine without loading material. The
material was removed when the
machine was ready to perform cutting.
The material came loose during cutting.

Switch off the power and contact your authorized Roland DG Corp. dealer.

Install the cutting tool again.
The cutting tool was installed in the
position for cutting perforated lines.



Installing the Cutting Tool

 

 



Menu Flow Chart





 



Specifications
Locations of the Power Rating and Serial Number Labels

Product name GR-640 GR-540 GR-420

Drive system Digital control servo motor

Cutting mechanism Media-moving method

Acceptable material
widths

156 to 1,802 mm 156 to 1,548 mm 156 to 1,224 mm

Separatable material
width

0 to 1,750 mm 0 to 1,496 mm 0 to 1,172 mm

Usable tools Roland CAMM-1 series blade (including blades for flatbed use)

Maximum cutting
speed

During cutting: 1,050 mm/sec. (all directions)
With blade raised: 1,485 mm/sec. (45° direction)

Cutting speed 10 to 1,050 mm/sec. (settable in steps of 10 mm/sec.)

Blade force 20 to 600 gf

Mechanical
resolution

0.005 mm/step

Software resolution 0.025 mm/step

Distance
accuracy (*1)

Error of less than ±0.2% of distance traveled or 0.1 mm, whichever
is greater

Repetition
accuracy (*1)(*2)
(*3)

0.1 mm or less

Interface
Ethernet (automatic switching between 10BASE-T and 100BASE-

TX), USB 2.0 (FULL SPEED compliant)

Replot memory 2 MB (buffer size: 8 MB)

Command system CAMM-GLⅢ

Power supply AC 100 to 240 V ±10%, 50/60 Hz, 0.7 A

Power consumption Approx. 70 W

Operating
noise

During
operation

67 dB (A) or less

During
standby

43 dB (A) or less

External dimensions
2,165 mm (width) ×
740 mm (depth) ×
1,190 mm (height)

1,910 mm (width) ×
740 mm (depth) ×
1,190 mm (height)

1,650 mm (width) ×
740 mm (depth) ×
1,190 mm (height)

Weight 93.5 kg (206.1 lb.) 87 kg (191.8 lb.) 78 kg (172.0 lb.)

2,300 mm (width) × 2,050 mm (width) × 1,740 mm (width) ×



Packed dimensions 565 mm (depth) ×
770 mm (height)

565 mm (depth) ×
770 mm (height)

565 mm (depth) ×
770 mm (height)

Packed weight 128 kg (282.2 lb.) 118 kg (260.2 lb.) 108 kg (238.1 lb.)

Environmental
Temperature: 5 to 40°C, humidity: 35%RH to 80%RH (no

condensation)

Included items

Power cord, power cord adapter, USB cable, cable clamp, blade
holder/blade/pin, alignment tool, separating knife replacement
blade, exclusive stand (for details, see the setup guide), setup

guide

*1: According to material and cutting conditions as specified by Roland DG Corporation 
*2: Excluding expansion/contraction of the material 
*3: [Range for assured repetition accuracy]
For material with a width exceeding 610 mm: Length 4,000 mm
For material with a width of 610 mm or less: Length 8,000 mm

Locations of the Power Rating and Serial Number Labels
The serial number is required for maintenance, servicing, and support. Never peel off
the label. 
Also, use a power supply that meets the requirements for voltage, frequency, and
amperage given on the label.

*: Serial number and power rating label
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Sending Data from
Illustrator/CorelDRAW

You can output cutting line data drawn with Adobe Illustrator or CorelDRAW to
CutStudio. 
To output data it is necessary to install a plug-in.

When Using Illustrator

Required Items

CutStudio
Plug-in for Illustrator

 

Installing Plug-in for Illustrator

Install CutStudio and Plug-in for Illustrator on the computer on which Illustrator is
installed.

Sending Data from Illustrator

Outputting Data Created in Illustrator

Viewing Help

Viewing Help (Illustrator)

http://startup.rolanddg.com/


When Using CorelDRAW

Required Items

CutStudio
Plug-in for CorelDRAW

 

Installing Plug-in for CorelDRAW

Install CutStudio and Plug-in for CorelDRAW on the computer on which CorelDRAW is
installed.

Sending Data from CorelDRAW

Outputting Data Created in CorelDRAW

Viewing Help

Viewing Help (CorelDRAW)

http://startup.rolanddg.com/


Outputting Data Created in
Illustrator

* The screenshots show an example of Illustrator CC 2015, but the operation procedure
is the same for other versions.

You must install Plug-in for Illustrator before proceeding.

Installing Plug-in for Illustrator

Procedure

Start Illustrator.

In Illustrator, click Extensions > Roland CutStudio
from the Window menu.

The "Roland CutStudio" palette appears.

http://startup.rolanddg.com/


Create a new file and create a new design or open
an existing file.

In this example, you will create the design shown in the figure below. Change
the characters to outline data.



When you select characters and click  on the palette, the characters
change to outline data.

Select Output All Lines.



On the Roland CutStudio palette, select the Auto
Update check box.

Check that the cutting line that you wish to output is shown on the preview
screen.



Click .

CutStudio starts, and the cutting line data is sent to CutStudio. 
The output data is always aligned at the origin of CutStudio regardless of the
position in Illustrator. (This does not apply to data with crop marks.)

Perform cutting.

Performing Cutting

When perform cutting from CutStudio, refer to the procedure of "Simple!
Basic Cutting."



Viewing Help (Illustrator)

Procedure

On the Roland CutStudio palette, click , and then
click Help.



Outputting Data Created in
CorelDRAW

You must install Plug-in for CorelDRAW before proceeding.

Procedure

Start CorelDRAW.

 

On the toolbar, click .

The "Roland CutStudio" palette appears.



Create a new document and create a new design or
open an existing file.

In this example, you will create the design shown in the figure below.
Convert the characters to curved lines.



When you select characters and click  on the palette, the characters
change to outline data.

Select Output All Lines.

Select the Auto Update check box.

Check that the cutting line that you wish to output is shown on the preview
screen.



Click .

CutStudio starts, and the cutting line data is sent to CutStudio. 
The output data is always aligned at the origin of CutStudio regardless of the
position in CorelDRAW.



The data created in CorelDRAW is output to CutStudio according
to the following conditions.

All graphics that are drawn are output to CutStudio. 
Character strings are not output to CutStudio. Convert character strings to
curved lines prior to outputting the data. 
Line width, fill, and arrows are ignored. 
Lines without width are not output. 
Images are not output.

Perform cutting.

When perform cutting from CutStudio, refer to the procedure of "Simple!
Basic Cutting."



Viewing Help (CorelDRAW)

Procedure

On the Roland CutStudio palette, click , and then
click Help.



Printing and Cutting

Printing and Cutting Overview

Your favorite picture can be printed and cut. This makes it easy to create your own
original stickers.

Flow Diagram

Create the data in CutStudio.
(You can also use Illustrator/CorelDRAW.)  

 

Print the data with the printer.
(Use the printer that you have on hand.)

 

Cut the printed material.



 

Your original sticker is complete!

Materials That Can Be Used for Printing and Cutting

Materials That Can Be Used for Printing and Cutting

Printing and Cutting with CutStudio

Preparations for Printing and Cutting (When Using CutStudio)

Printing and Cutting Procedure (CutStudio)

Printing and Cutting with Plug-ins

Printing and Cutting with Illustrator

Preparations for Printing and Cutting (When Using Illustrator)

Printing and Cutting Procedure (Illustrator)

Printing and Cutting with CorelDRAW

Preparations for Printing and Cutting (When Using CorelDRAW)

Printing and Cutting Procedure (CorelDRAW)

Printing and Cutting with a Roland DG Corp. Printer
Use Roland VersaWorks Dual to perform printing and cutting. 
For the method to use, see the Roland VersaWorks Dual help.

Printing and Cutting without Using the Included Software

Preparations for Printing and Cutting (Manual Mode)

Printing and Cutting Procedure (Manual Mode)



Materials That Can Be Used for
Printing and Cutting

Use material with carrier paper that can be printed on a laser or inkjet printer.

Material portion type

Laser printer Fine paper, coated paper, art paper, and PET
(Polyethylene Terephthalate)

Inkjet printerVinyl chloride material, fine paper, and coated paper
Color White

* Automatic detection may not be possible for some materials,
such as laminated or glossy materials.

If automatic detection is not possible, align the crop marks using the alignment tool.

Cutting in Tool Mode (1)



Preparations for Printing and
Cutting (When Using CutStudio)

Printing and Cutting Sample Data
We recommend that you get comfortable with the printing and cutting procedure by
using the sample data first. 
In this procedure, you will create the sticker shown below.

Printing and Cutting Procedure (CutStudio)

Items Required Other than the Machine

Printer A computer with CutStudio
installed

Material (210 x 298 mm) Sample data

Printer Requirements



You must use a laser or inkjet printer with a resolution of 720 dpi or greater.

If the printed filled sections are blurred, crop marks will not be read correctly.

CutStudio

Be sure to install this program. Only CutStudio can be used to perform printing
and cutting operations.

http://startup.rolanddg.com/

Materials That Can Be Used for Printing and Cutting

This example uses A4-size material.

Materials That Can Be Used for Printing and Cutting

Sample Data

Open the Sample.bmp file found in the CutStudio installation folder (usually located
in the CutStudio folder under Program Files on the C drive).

Sample Data Cannot Be Found

Printing and Cutting Procedure (CutStudio)

http://startup.rolanddg.com/


Printing and Cutting Procedure
(CutStudio)

Procedure

Step 1: Set the Printing and Cutting Areas

Step 2: Import the Sample Data

Step 3: Draw the Cutting Lines

Step 4: Perform Printing

Step 5: Load the Printed Material

Step 6: Set the Alignment Method (Sensor Mode)

Step 7: Perform Cutting (Sensor Mode)

 



Step 1: Set the Printing and
Cutting Areas

Procedure

Start CutStudio.

Windows 10 and Windows 7

On the Start menu, click All Programs (or Programs), click Roland CutStudio, and
then click CutStudio.

Windows 8.1

At the lower left of the Start screen, click  to display the Apps screen. Click 
.

The screen shown below appears.

From the File menu, click Cutting Setup.



Use Name under Printer to select the model name
of the machine on hand.

Click OK.

 

From the File menu, click Print & Cut.



The printing area and crop marks are displayed on the screen. The printing
area is displayed with dotted lines. This area corresponds to the paper size
specified in Set up the printer excluding the margins specified in Printing
Setup.

 (1) Printing area
 (2) Crop mark

From the File menu, click Printing Setup.



Click Printer Setup.



Set the document size, and then click OK.

 

Click Fit into shared area for cutting and printing.

The crop mark location is set automatically.

For guidelines when setting the margins and crop marks, see
"Setting the Margins and the Distance between Crop Marks."



Click OK.

After setting the values, check that the crop marks are within the printing
area.

* Ensure that the crop marks do not project outside of the dotted lines.

Step 2: Import the Sample Data



Step 2: Import the Sample Data

File Formats That Can Be Imported into CutStudio

JPEG format
* JPEG files saved in CMYK format cannot be imported.

BMP format

AI, EPS format (Illustrator 8.0 version)
* Illustrator 8.0 and EPS 8.0 are the importable file formats. If using a higher
version, save files as a lower version before importing.

Procedure

Click  to import image data.

Here, open the Sample.bmp file found in the CutStudio installation folder
(usually located in the CutStudio folder under Program Files on the C drive). 
The screen below is displayed.

Sample Data Cannot Be Found

Illustrator Data Cannot Be Imported

 



Select the image data, and then click Open.

Position the image data in the area within the crop
marks.

 Position the data within this area.

You can change the darkness of the imported image.



For more details, refer to "Changing the Darkness of an Aligned Image."

Step 3: Draw the Cutting Lines



Step 3: Draw the Cutting Lines

Procedure

Click , and then draw the cutting lines.

If using the sample data, draw the line as shown below.

Cutting line

Click .

Save the data.

 

Step 4: Perform Printing

 



Step 4: Perform Printing

Procedure

Load the material in the printer.

For details on how to load the material, see the instruction
manual for your printer.

* When expanded/reduced printing is enabled, disable it.
Print at 100% scale.

Click .

Select the printer you want to use, and then click
OK.



The image is printed as shown in the figure below. 
* Cutting lines are not printed.

 

Step 5: Load the Printed Material



Step 5: Load the Printed Material

Procedure

Check the origin for cutting of the printed material.

Turn on the cutting machine.
Wait for the initial operation to finish.

 

Set the origin for cutting to the lower-left corner of
the material, and then load the material in the
machine.

If the material is loaded in the wrong direction, the machine
will not be able to read the crop marks.



Position the left and right pinch rollers as shown in
the figure.

For A4-size material, do not use the middle pinch rollers.

Using Narrow Material/Preventing Marking Made by the Middle Pinch Rollers

(1) Position the pinch rollers outside the tool marks.
(2) Be sure that both edges of the material and the pinch rollers
are inside the grit patterns.



Align the right edge of the material with the front
and back gradations of the platen.

Select the type of material.

Press [ENTER].

The pinch rollers lower and the carriage and material move. 
When the movement is finished, the cuttable width and length are displayed.

Press [ ] and [ ] to move the material and position
the crop marks above the blade protector.

(1) Blade protector
(2) Crop marks



Press [ ] and [ ] to position the tip of the blade
over the center of the lower-left crop mark.

Do not set the origin.

 

Crop marks cannot be read in the situations indicated below.

If any of the following situations occur, remove the material, and then reload it.

The left and right crop marks are slanted by 5 degrees or more with respect to
the moving direction of the cutting carriage.
The left and right crop marks are offset by 20 mm or more in the material-feed
direction.

The crop marks are separated from the blade protector by a distance of 15 mm
or more.



     *: Blade protector

The material sometimes curls when it is printed on the printer. 
Do not use material that is curled as shown in the figure. The crop marks may not
be read. If this happens, straighten out the material before loading it on the cutting
machine.

Step 6: Set the Alignment Method (Sensor Mode)



Step 6: Set the Alignment Method
(Sensor Mode)

Position the crop marks automatically using the machine's integrated sensor.

Procedure

Press [MENU] several times to display the screen
shown in the figure.

Press [ ] several times to display the screen
shown in the figure.

Press [ ] and select SENSOR MODE.

Press [ENTER] to select the setting.

Press [MENU] to return to the screen shown in the figure.



Step 7: Perform Cutting (Sensor Mode)



CAUTION

Step 7: Perform Cutting (Sensor
Mode)

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into contact
with the moving carriage may cause injury.

Procedure

Set the material size.

Creating Cutting Data (2)

Click .

If you want to change the cutting conditions, click Change, clear the Use
cutting conditions of machine check box, and then enter the values.



Click OK.

The cutting data is sent to the machine. When the machine receives the data, it
automatically reads the crop marks using a sensor, and then starts cutting.

 

If the sensor fails to read the crop marks

If the sensor fails to read the crop marks, the screen in the figure appears. If this
screen appears, see "Crop Marks Cannot be Read." If this does not resolve the
issue, refer to "Cutting in Tool Mode (1)," and then perform positioning in tool
mode.

Remove the cut material.

Removing the Material

This completes the cutting procedure.



Preparations for Printing and
Cutting (When Using Illustrator)

Printing and Cutting Sample Data
We recommend that you get comfortable with the printing and cutting procedure by
using the sample data first. 
In this procedure, you will create the sticker shown below.

Printing and Cutting Procedure (Illustrator)

Items Required Other than the Machine

Printer Material (210 x 298 mm) Sample data

A computer on which CutStudio, Illustrator, and Plug-In for Illustrator are installed

Printer Requirements



You must use a laser or inkjet printer with a resolution of 720 dpi or greater.

If the printed filled sections are blurred, crop marks will not be read correctly.

Cut Studio/Plug-In for Illustrator

Be sure to install these programs.

http://startup.rolanddg.com/

Material

This example uses A4-size material.

Materials That Can Be Used for Printing and Cutting

Sample Data

Open the Sample.bmp file found in the CutStudio installation folder (usually located
in the CutStudio folder under Program Files on the C drive).

Sample Data Cannot Be Found

Printing and Cutting Procedure (Illustrator)

http://startup.rolanddg.com/


Printing and Cutting Procedure
(Illustrator)

Procedure

Step 1: Set the Printing and Cutting Areas

Step 2: Position the Sample Data

Step 3: Draw the Cutting Lines

Step 4: Perform Printing

Step 5: Load the Printed Material

Step 6: Set the Alignment Method (Sensor Mode)

Step 7: Perform Cutting (Sensor Mode)

 



Step 1: Set the Printing and
Cutting Areas

Procedure

Start Illustrator and open a new document.

Set the artboard.

From the Window menu, click Extensions, and then
click Roland CutStudio.

The Roland CutStudio palette appears.



On the palette, click .

Crop marks are inserted in the artboard.



Click , and then click Crop marks.

Select the model name from the Type list, and then
select 4 from the Point list.



Point: Set the number of crop marks.

Set the margins, and then click OK.

Setting the Margins and the Distance between Crop Marks

Step 2: Position the Sample Data



Step 2: Position the Sample Data

Procedure

Position the image data in the area within the crop
marks.

 Position the data within this area.

Step 3: Draw the Cutting Lines



Step 3: Draw the Cutting Lines

Procedure

Draw the cutting lines.

Create a new layer for the cutting lines and draw the cutting lines there.

 Newly created layer

Cutting line

Save the data.

 

Step 4: Perform Printing

 



Step 4: Perform Printing

Procedure

Load the material in the printer.

For details on how to load the material, see the instruction
manual for your printer.

* When expanded/reduced printing is enabled, disable it.
Print at 100% scale.

Hide the layer containing the cutting lines.



From the File menu, click Print.

The image is printed as shown in the figure below.

 

Step 5: Load the Printed Material



Step 5: Load the Printed Material

Procedure

Check the origin for cutting of the printed material.

Turn on the cutting machine.
Wait for the initial operation to finish.

 

Set the origin for cutting to the lower-left corner of
the material, and then load the material in the
machine.

If the material is loaded in the wrong direction, the machine
will not be able to read the crop marks.



Position the left and right pinch rollers as shown in
the figure.

For A4-size material, do not use the middle pinch rollers.

Using Narrow Material/Preventing Marking Made by the Middle Pinch Rollers

(1) Position the pinch rollers outside the tool marks.
(2) Be sure that both edges of the material and the pinch rollers
are inside the grit patterns.



Align the right edge of the material with the front
and back gradations of the platen.

Select the type of material.

Using Various Types of Materials

Press [ENTER].

The pinch rolls lower and the carriage and material move. 
When the movement is finished, the cuttable width and length are displayed.

Use [ ] and [ ] to move the material and position
the crop marks above the blade protector.

(1) Blade protector
(2) Crop marks



 

Press [ ] and [ ] to position the tip of the blade
over the center of the lower-left crop mark.

Do not set the origin.

 

Crop marks cannot be read in the situations indicated below.

If any of the following situations occur, remove the material, and then reload it.

The left and right crop marks are slanted by 5 degrees or more with respect to
the moving direction of the cutting carriage.
The left and right crop marks are offset by 20 mm or more in the material-feed
direction.

The crop marks are separated from the blade protector by a distance of 15 mm



or more.

     *: Blade protector

The material sometimes curls when it is printed on the printer. 
Do not use material that is curled as shown in the figure. The crop marks may not
be read. If this happens, straighten out the material before loading it on the cutting
machine.

Step 6: Set the Alignment Method



Step 6: Set the Alignment Method
(Sensor Mode)

Position the crop marks automatically using the machine's integrated sensor.

Procedure

Press [MENU] several times to display the screen
shown in the figure.

Press [ ] several times to display the screen
shown in the figure.

Press [ ], [ ], and then press [ ] to select
SENSOR MODE.

Press [ENTER] to select the setting.

Press [MENU] to return to the screen shown in the figure.



Step 7: Perform Cutting (Sensor Mode)



CAUTION

Step 7: Perform Cutting
(Sensor Mode)

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Procedure

Show the layer containing the cutting lines and
select it.

Check that all the cutting lines that you wish to cut are shown on the
palette's preview screen.

On the Roland CutStudio palette, select Output
Current Layer, and then click Update.

Check that all the cutting lines that you wish to cut are shown on the
palette's preview screen.



Click .

CutStudio starts, and the cutting data is sent to CutStudio.



In CutStudio, click .

The screen shown in the following figure is displayed.

Click OK.

The cutting data is sent to the machine. When the machine receives the data,
it automatically reads the crop marks using a sensor, and then starts cutting.

Crop Marks Cannot Be Read



If the Sensor Fails to Read the Crop Marks

If the sensor fails to read the crop marks, the screen in the figure appears. If
this screen appears, proceed to "Crop Marks Cannot Be Read." If this does
not resolve the issue, refer to "Cutting in Tool Mode (1)," and then perform
positioning in tool mode.

Remove the cut material.

Remove the material to complete the cutting procedure.

Removing the Material



Preparations for Printing and
Cutting (When Using CorelDRAW)

Printing and Cutting Sample Data
We recommend that you get comfortable with the printing and cutting procedure by
using the sample data first. 
In this procedure, you will create the sticker shown below.

Printing and Cutting Procedure (CorelDRAW)

Items Required Other than the Machine

Printer Material (210 x 298 mm) Sample data

A computer on which CutStudio, CorelDRAW, and Plug-in for CorelDRAW are installed

Printer Requirements



You must use a laser or inkjet printer with a resolution of 720 dpi or greater.

If the printed filled sections are blurred, crop marks will not be read correctly.

CutStudio/Plug-In for CorelDRAW

Be sure to install these programs.

http://startup.rolanddg.com/

Material

This example uses A4-size material.

Materials That Can Be Used for Printing and Cutting

Sample Data

Open the Sample.bmp file found in the CutStudio installation folder (usually located
in the CutStudio folder under Program Files on the C drive).

Sample Data Cannot Be Found

Printing and Cutting Procedure (CorelDRAW)

http://startup.rolanddg.com/


Printing and Cutting Procedure
(CorelDRAW)

Procedure

Step 1: Set the Printing and Cutting Areas

Step 2: Position the Sample Data

Step 3: Draw the Cutting Lines

Step 4: Perform Printing

Step 5: Load the Printed Material

Step 6: Set the Alignment Method (Sensor Mode)

Step 7: Perform Cutting (Sensor Mode)

 



Step 1: Set the Printing and
Cutting Areas

Procedure

Start CorelDRAW, and then open a new document.

Set the document size.

Click the plug-in's start button on the toolbar.

The Roland CutStudio palette appears.



On the palette, click .

Crop marks are inserted in the document.



Click , and then click Crop marks.

In the Type list, select GR-640/540/420. In the
Point list, select 4.



Point: Set the number of crop marks.

Set the margins, and then click OK.

Setting the Margins and the Distance between Crop Marks

Step 2: Position the Sample Data



Step 2: Position the Sample Data

Procedure

Position the image data in the area within the crop
marks.

 Position the data within this area.

Step 3: Draw the Cutting Lines



Step 3: Draw the Cutting Lines

Procedure

Draw the cutting lines.

Create a new layer for the cutting lines and draw the cutting lines there.

 Newly created layer

Cutting line

Save the data.

 

Step 4: Perform Printing

 



Step 4: Perform Printing

Procedure

Load the material in the printer.

For details on how to load the material, see the instruction
manual for your printer.

* When expanded/reduced printing is enabled, disable it.
Print at 100% scale.

Hide the layer containing the cutting lines.



From the File menu, click Print.

The image is printed as shown in the figure below.

 

Step 5: Load the Printed Material



Step 5: Load the Printed Material

Procedure

Check the origin for cutting of the printed material.

Turn on the cutting machine.
Wait for the initial operation to finish.

 

Set the origin for cutting to the lower-left corner of
the material, and then load the material in the
machine.

If the material is loaded in the wrong direction, the machine
will not be able to read the crop marks!



Position the left and right pinch rollers as shown in
the figure.

For A4-size material, do not use the middle pinch rollers.

Using Narrow Material/Preventing Marking Made by the Middle Pinch Rollers

(1) Position the pinch rollers outside the tool marks.
(2) Be sure that both edges of the material and the pinch rollers
are inside the grit patterns.



Align the right edge of the material with the front
and back gradations of the platen.

Select the type of material.

Using Various Types of Materials

Press [ENTER].

The pinch rolls lower and the carriage and material move. 
When the movement is finished, the cuttable width and length are displayed.

Use [ ] and [ ] to move the material and position
the crop marks above the blade protector.

(1) Blade protector
(2) Crop marks



 

Press [ ] and [ ] to position the tip of the blade
over the center of the lower-left crop mark.

Do not set the origin.

 

Crop marks cannot be read in the situations indicated below.

If any of the following situations occur, remove the material, and then reload it.

The left and right crop marks are slanted by 5 degrees or more with respect to
the moving direction of the cutting carriage.
The left and right crop marks are offset by 20 mm or more in the material-feed
direction.

The crop marks are separated from the blade protector by a distance of 15 mm
or more.



     *: Blade protector

The material sometimes curls when it is printed on the printer. 
Do not use material that is curled as shown in the figure. The crop marks may not
be read. If this happens, straighten out the material before loading it on the cutting
machine.

Step 6: Set the Alignment Method



Step 6: Set the Alignment Method
(Sensor Mode)

Position the crop marks automatically using the machine's integrated sensor.

Procedure

Press [MENU] several times to display the screen
shown in the figure.

Press [ ] several times to display the screen
shown in the figure.

Press [ ], [ ], and then press [ ] to select
SENSOR MODE.

Press [ENTER] to select the setting.

Press [MENU] to return to the screen shown in the figure.



Step 7: Perform Cutting (Sensor Mode)



CAUTION

Step 7: Perform Cutting
(Sensor Mode)

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Procedure

Show the layer containing the cutting lines and
select it.

Check that all the cutting lines that you wish to cut are shown on the
palette's preview screen.

On the Roland CutStudio palette, select Output
Current Layer, and then click Update.

Check that all the cutting lines that you wish to cut are shown on the
palette's preview screen.



Click .

CutStudio starts, and the cutting data is sent to CutStudio.



In CutStudio, click .

The screen shown in the following figure is displayed.

Click OK.

The cutting data is sent to the machine. When the machine receives the data,
it automatically reads the crop marks using a sensor, and then starts cutting.

Crop Marks Cannot Be Read



If the Sensor Fails to Read the Crop Marks

If the sensor fails to read the crop marks, the screen in the figure appears. If
this screen appears, proceed to "Crop Marks Cannot Be Read." If this does
not resolve the issue, refer to "Cutting in Tool Mode (1)," and then perform
positioning in tool mode.

Remove the cut material.

Remove the material to complete the cutting procedure.

Removing the Material



Preparations for Printing and
Cutting (Manual Mode)

Printing and Cutting Sample Data
If you use the manual mode, you can perform printing and cutting without using
CutStudio and Illustrator. We recommend that you get comfortable with the printing
and cutting procedure by using the sample data first. In this procedure, you will
create the sticker shown below.

Items Required Other than the Machine

Printer Material (210 x 298 mm) Sample data

Printer Requirements

You must use a laser or inkjet printer with a resolution of 720 dpi or greater.

Materials That Can Be Used

Materials That Can Be Used for Printing and Cutting

Sample Data



Open the Sample.bmp file found in the CutStudio installation folder (usually located
in the CutStudio folder under Program Files on the C drive).

Sample Data Cannot Be Found

Printing and Cutting Procedure (Manual Mode)



Printing and Cutting Procedure
(Manual Mode)

Procedure

Step 1: Create Crop Mark Data Manually

Step 2: Perform Printing

Step 3: Load the Printed Material

Step 4: Set the Alignment Method (Manual Mode)

Step 5: Perform Cutting (Manual Mode)

 



Step 1: Create Crop Mark Data
Manually

Create Crop Mark Data in Software Other than CutStudio,
Illustrator, or CorelDRAW

When drawing crop marks to add to an illustration in application software, take into
account the margin necessary for cutting the material when setting the crop mark
position.

Crop Marks/Tool Marks

Procedure

Draw crop marks.

There is no particular design that should be used for crop marks, but using
shapes with corners as shown in the figure below facilitates alignment.

Set the margins.

When using material with a large amount of feed (long material), we
recommend that you set the left and right margins to approximately 25 mm.



Make a note of the distance between the crop
marks (WIDTH and LENGTH).

You will enter these values into the machine later.

WIDTH

LENGTH

Make a note of the offset values.

Check the origin (the point where both X and Y are 0) of the software that
you are using. 
Make a note of the distance between this origin and the lower-left crop mark.

Here, the lower-left corner of the paper surface is the origin in the software.
Later explanations assume that the distance from the origin to the lower-left



crop mark has the positional relationship shown in the following figure.

Offset L: 45 mm
Offset W: 25 mm

Draw the illustration in the cutting area within the
crop marks.

Step 2: Perform Printing



Step 2: Perform Printing

Procedure

Load the material in the printer.

For details on how to load the material, see the instruction
manual for your printer.

* When expanded/reduced printing is enabled, disable it.
Print at 100% scale.

Step 3: Load the Printed Material



Step 3: Load the Printed Material

Procedure

Load the material.

Refer to "Step 5: Load the Printed Material" and ready the machine.

Step 4: Set the Alignment Method (Manual Mode)



Step 4: Set the Alignment Method
(Manual Mode)

Referring to the Menu Flow Chart as you proceed will help the setting procedure go
smoothly.

(1) Select Manual Mode

Procedure

Press [MENU] several times to display the screen
shown in the figure.

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Press [ ] to select MANUAL.



Press [ENTER].

Press [ ] twice.

(2) Enter the Distance between the Crop Marks
Enter the values that you made a note of in Step 1, No. 3.

WIDTH

LENGTH

Procedure

Press the [ ] key, and then press the [ ] key to



display the screen shown in the figure.

 

Use [ ] and [ ] to enter the horizontal distance
(WIDTH) between the crop marks.

Use [ENTER] to select the setting.

Press the [ ] key, and then press the [ ] key.

Use [ ] and [ ] to enter the vertical distance
(LENGTH) between the crop marks.

Use [ENTER] to select the setting.



 

(3) Enter the Offset Values
Enter the values that you made a note of in Step 1, No. 4.

If you want to further reduce the misalignment after seeing the result of printing
and cutting, measure the amount of cutting line misalignment, and then add this
measured value to or subtract this measured value from the offset values. 
Set the values as required.

Procedure

Press the [ ] key, and then press the [ ] key.

 

Use [ ] and [ ] to enter the amount of cutting
line misalignment (in the width direction).



Use [ENTER] to select the setting.

Press the [ ] key, and then press the [ ] key.

Use [ ] and [ ] to enter the amount of cutting
line misalignment (in the length direction).

Use [ENTER] to select the setting.

Step 5: Perform Cutting (Manual Mode)

 



CAUTION

Step 5: Perform Cutting
(Manual Mode)

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Referring to the Menu Flow Chart as you proceed will help the setting procedure go
smoothly.

Procedure

Press the [ ] key, and then press the [ ] key to
select 4-POINT START.

If using 3 crop marks, select 3-POINT START. The screen shown in the
following figure is displayed.

 

Press [ENTER].

The screen shown in the following figure is displayed.

 



Perform steps 3 to 13 in "Cutting in Tool Mode
(2)."

Even if you perform all the steps up to step 13 in Cutting in Tool Mode (2),
cutting will not start.

To start cutting, perform step 4 shown below.

When the screen shown in the figure below is
displayed, send data from the computer.

When the machine receives the data, it starts cutting.

Remove the cut material.

Remove the material to complete the cutting procedure.

Removing the Material



Crop Marks/Tool Marks

Crop Marks
Crop marks are used for alignment when cutting printed material on the cutting
machine. Having the machine remember the positions of the crop marks printed
together with the image makes it possible to correct cutting positions.

 Crop Marks

When to Use 4 Crop Marks vs 3 Crop Marks

In most cases you should use 4 crop marks. If you use 3 crop marks, it is not
possible to use Tool Mode.

Switching between 3 and 4 Crop Marks

 

Readable Crop Marks

The sensor of the machine is only able to read crop marks like the circle shown
below.

Diameter:10 mm
Color: Black

* The machine may not be able to read the printed crop marks correctly depending
on the printer ink.



 

Setting the Margins and the Distance between Crop Marks

Take into account the margin necessary for cutting the material and set the crop
mark position.

When Using CutStudio

When Using Illustrator/CorelDRAW

 

Tool Marks
Tool marks are used for manual alignment when it is not possible to perform
automatic alignment using crop marks. Tool marks are printed around the crop
marks when using the included CutStudio and plug-in software.

 Tool marks

Cutting in Tool Mode (1)



Switching between 3 and 4 Crop
Marks

In most cases you should use 4 crop marks.

 (1) Printing area
 (2) Crop mark

Switching to 3 Crop Marks

CutStudio

Procedure

From the File menu, click Printing Setup.



 

From the Layout Points list, select 3.



 

Click OK.

After setting the values, check that the crop marks are within the printing area.



Setting the Margins and the Distance between Crop Marks

Illustrator

Procedure

Click , and then click Crop marks.

From the Point list, select 3.

 

Click OK.

 



CorelDRAW

Procedure

Click , and then click Crop marks.

From the Point list, select 3.

 

Click OK.

 



Setting the Margins and the Distance between Crop Marks



Setting the Margins and the
Distance between Crop Marks

Set the margins and the distance between crop marks. 
Take into account the margin necessary for cutting the material and set the crop mark
position.

When Using CutStudio

<crop marks: 3 points>, <crop marks: 4 points>

Size Margin and crop mark settings

A4 portrait Top: 30 mm, bottom: 45 mm, left: 10 mm, right: 10 mm
W: 170 mm, L: 202 mm

A4 landscape Top: 30 mm, bottom: 45 mm, left: 10 mm, right: 10 mm
W: 257 mm, L: 115 mm

A3 portrait Top: 30 mm, bottom: 45 mm, left: 10 mm, right: 10 mm
W: 257 mm, L: 325 mm

A3 landscape Top: 30 mm, bottom: 45 mm, left: 10 mm, right: 10 mm
W: 380 mm, L: 202 mm



B4 portrait Top: 30 mm, bottom: 45 mm, left: 10 mm, right: 10 mm
W: 217 mm, L: 269 mm

B4 landscape Top: 30 mm, bottom: 45 mm, left: 10 mm, right: 10 mm
W: 324 mm, L: 162 mm

* When using material with a large amount of feed (long material), we recommend
that you set the left and right margins to approximately 25 mm.

* If you are using material that is larger than the sizes listed
above, set the values by referring to the figure below.

: Printable area
: Ensure that only crop marks are present within this area and that it is free of any
other illustrations and dirt.

When Using Illustrator/CorelDRAW



* When using material with a large amount of feed (long material), we recommend
that you set the left and right margins to approximately 25 mm.

<crop marks: 3 points>, <crop marks: 4 points>

Size Crop mark positions

A4 portrait X: 10 mm, Y: 45 mm
W: 170 mm, L: 202 mm

A4 landscape X: 10 mm, Y: 45 mm
W: 257 mm, L: 115 mm

A3 portrait X: 10 mm, Y: 45 mm
W: 257 mm, L: 325 mm

A3 landscape X: 10 mm, Y: 45 mm
W: 380 mm, L: 202 mm

B4 portrait X: 10 mm, Y: 45 mm
W: 217 mm, L: 269 mm

B4 landscape X: 10 mm, Y: 45 mm
W: 324 mm, L: 162 mm

* If you are using material that is larger than the sizes listed
above, set the values by referring to the figure below.



: Cuttable area
: Ensure that only crop marks are present within this area and that it is free of any
other illustrations and dirt.



Cutting in Tool Mode (1)

When to Use Tool Mode

■ When it is not possible to perform alignment in Sensor Mode
■ When printing and cutting without selecting the type of material

It is not possible to use Tool Mode when using only 3 crop marks.

Required Items

Alignment tool Material on which tool marks have
been printed

 

(1) Load the Material

Procedure

Perform preparations for cutting.

Perform the procedure at the following link.

Loading Flat Material

(2) Set Tool Mode

Procedure



Press [MENU] several times to display the screen
shown in the figure.

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

Press [ ] to select TOOL MODE.

 

Press [ENTER].

 



Cutting in Tool Mode (2)



Cutting in Tool Mode (2)

Send Cutting Data and Perform Alignment
 

Send the cutting data.

 

The screen shown in the figure appears.

Install the alignment tool.

The installation method is the same as that of the cutting tool.

Installing the Cutting Tool

When installation is complete, press [ENTER].

The tool moves to a position near the lower-left crop mark and stops, and the
screen shown in the figure appears.



Use the [ ], [ ], [ ], and [ ] buttons to align the
tip of the alignment tool with tool mark 1.

Hold down the alignment tool gently from above with your finger and check that
the tip of the alignment tool overlaps the tool mark.

Press [ENTER].

The tool moves to a position near the lower-right crop mark, and the screen
shown in the figure appears.

To Redo Alignment

Align the tip of the alignment tool with tool mark 2.



Press [ENTER].

The tool moves to a position near the upper-left crop mark, and the screen
shown in the figure appears.

Align the upper-left and upper-right tool marks in the
same way.

After aligning mark 4, press [ENTER].

The screen shown in the figure appears.

Remove the alignment tool and install the cutting
tool.



Press [ENTER].

 

Press [ENTER].

Cutting starts.

 

To Redo Alignment

You can press [MENU] during alignment to return to the previous screen and redo
the alignment procedure.



Cutting Perforated Lines

Overview of Cutting Perforated Lines
The machine can also cut material without carrier paper, such as coated paper. 
This function makes it easy to create point-of-purchase advertisements, cards, and
other materials.

Cutting Perforated Lines with CutStudio

Step 1: Perform Preparations for Cutting

Step 2: Create Perforated Line Data

Step 3: Set Perforated Cutting Conditions

Step 4: Cut Perforated Lines

Cutting Perforated Lines with Illustrator

Outputting Perforated Line Data from Illustrator

Cutting Perforated Lines with CorelDRAW

Outputting Perforated Line Data from CorelDraw



Step 1: Perform Preparations for
Cutting

Procedure

Perform preparations for cutting.

Click the link below and perform the procedures from
"Loading Roll Material" to "Creating Cutting Data (2)." 
Exercise caution regarding the position in which the cutting
tool is installed.

Loading Roll Material

When cutting perforated lines, install the cutting tool in the position shown in the
figure. 
Note that this is the position in front of the normal installation position.

Step 2: Create Perforated Line Data



Step 2: Create Perforated Line
Data

Procedure

Create a shape or similar object.

In this example, you will create a circle like that shown in the figure below.

Click .

Objects set with perforated lines are displayed in red.



From the File menu, click Preferences to display the Preferences dialog
box. This lets you set the color and display of perforated lines.

Step 3: Set Perforated Cutting Conditions

Canceling Perforated Line Settings

Procedure

Use the  tool to select the shape for which you
want to cancel perforated line settings.

 

Click .

The cutting lines turn black.



 

Step 3: Set Perforated Cutting Conditions



Step 3: Set Perforated Cutting
Conditions

Procedure

From the File menu, click Cutting Setup.

Clear the Use perforated cutting conditions of
machine check box.



You can now enter the values.

Enter the Perforated Cutting Conditions.

Set the length of each perforation to make in the material (the perforation
length) and the length of the part that is not perforated because the blade force
is reduced (the half-cut length). 
Adjust the half-cut force to suit the type of material or paper used.

About the Perforation length/Half-cut length

   *1: Perforation length
   *2: Half-cut length

Perforation length > Half-cut length



Perforation length = Half-cut length

Perforation length < Half-cut length

Click OK.

 

Step 4: Cut Perforated Lines



CAUTION

Step 4: Cut Perforated Lines

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Procedure

Click .

The screen shown in the following figure is displayed. Select the type of
cutting lines you want to use from the list.

[All]: The cutting lines and the perforated cutting lines will be output.
[Cut Lines Only]: Only the cutting lines will be output.
[Perforated Cut Lines Only]: Only the perforated cutting lines will be output.

Checking the Installed Position of the Cutting Tool Each Time
before Cutting

Frequently Using Perforated Cutting



Click OK.

Cutting starts.

Adjusting Perforated Cutting Conditions

Select optimum cutting conditions on the basis of the cutting results.

Optimizing the Cutting Quality for the Material



Outputting Perforated Line Data
from Illustrator

* The screenshots show an example of Illustrator CC 2015, but the operation procedure
is the same for other versions.

* You must install Plug-in for Illustrator before proceeding.

Installing Plug-in for Illustrator

Procedure

Create a new file and create a new design or open
an existing file.

In this example, you will create the design shown in the figure below.

http://startup.rolanddg.com/


From the Window menu, click Extensions, and then
click Roland CutStudio.

The Roland CutStudio palette appears.

Select the object that you want to apply perforated
lines to.



Click .

Select Output Perforated Cut Lines.



On the Roland CutStudio palette, click Update.

Check that the cutting line that you wish to output is shown on the preview
screen.

Click .

CutStudio starts, and the cutting line data is sent to CutStudio. 
The output data is always aligned at the origin of CutStudio regardless of the
position in Illustrator. (This does not apply to data with crop marks.)



Perform cutting.

Performing Cutting



Outputting Perforated Line Data
from CorelDraw

* The screenshots show an example of CorelDRAW X8, but the operation procedure is
the same for other versions.

* You must install Plug-in for CorelDRAW before proceeding.

Installing Plug-in for CorelDRAW

Procedure

Create a new document and create a new design or
open an existing file.

In this example, you will create the design shown in the figure below.

Click the plug-in's start button on the toolbar.

http://startup.rolanddg.com/


The Roland CutStudio palette appears.

Select the object that you want to apply perforated
lines to.



Click .

Select Output Perforated Cut Lines.



On the Roland CutStudio palette, click Update.

Check that the cutting line that you wish to output is shown on the preview
screen.

Click .

CutStudio starts, and the cutting line data is sent to CutStudio. 
The output data is always aligned at the origin of CutStudio regardless of the
position in CorelDRAW. (This does not apply to data with crop marks.)



Perform cutting.

Performing Cutting



Tiled Output

Overview of Tiled Output
Tiled output lets you split up data that is larger than the cutting area over multiple
sheets.

* Tiled output does not support the printing and cutting
operation.

 

Inner Margin Function

■ Without inner margin: Gap between edges

 

■ With inner margin: No gap between edges

Inner margin



 

Procedure

Step 1: Determine Output Size

Step 2: Load the Material

Step 3: Set Tiled Output Conditions

Step 4: Enter Text and Shapes

Step 5: Check Preview

Step 6: Perform Cutting



Step 1: Determine Output Size
Remember the basic procedure for tiled output while creating a large sticker like the one shown below. 
Follow the procedure below.

Overview

In this example, you will create an image with the dimensions indicated below.

Keeping the completed size in mind when working will help the setting procedure go smoothly.

Procedure

Determine the output size.



Check the size of the material to be used.

Step 2: Load the Material

 



Step 2: Load the Material

Procedure

Perform steps 1 to 8 in the procedure under
"Loading Roll Material."

Loading Roll Material

 

Step 3: Set Tiled Output Conditions



Step 3: Set Tiled Output Conditions

Procedure

Start CutStudio.

From the File menu, click Tiling.

The Tiling dialog box is displayed.



Click Change Size.

Click Get from Machine.

The cutting area is entered automatically. Once the cutting area has been
entered, click OK.



The segment size is updated.



Select the Tiled Output check box, and then enter
the number of tiles.



Enter a value for the inner margin, then click OK.

To enter a value for the inner margin, the overall size is updated automatically.
Make sure Overall Size is larger than the size of the data determined in Step 1.

Inner Margin Function



The document is displayed. 
The edges of the segments are displayed even if an inner margin has not been
set.

W: Overall Size
width
L: Overall Size
length
*1 Inner margin

Step 4: Enter Text and Shapes



Step 4: Enter Text and Shapes

Procedure

Enter text and/or shapes as desired.

In this example, you will enter the data shown in the figure below.

Step 5: Check Preview



Step 5: Check Preview

Procedure

From the File menu, click Cutting Preview.

Click Next Page to display the segments in the cutting order.

Cutting Order



Step 6: Perform Cutting

 



CAUTION

Step 6: Perform Cutting

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Procedure

Make sure the material is loaded in the machine.

 

Click .

Click OK.



Click OK.

Cutting starts. 
When cutting finishes, the message shown below will be displayed.

Click OK.

If you are using flat material, load new material before you click OK.

Removing the Material

Loading Flat Material



Cutting starts.

Repeat steps 3 and 4 in this procedure.

Output the set number of tiles.

 

Combine the output material.

Align the margins to complete the procedure.



Other Things That You Can Do

Changing or Checking the Machine's Operation

Changing the Language Used for the Display

Setting the Displayed Unit

Initializing All Settings to Their Default Values

Checking the Machine Status <Self Test>

Changing the Contrast of the Display Screen

Frequently Using Perforated Cutting

 

Minimizing Wasted Material

Setting the Direction of the Coordinate Axis for Cutting <ROTATE>

Extending the Cutting Area <EXTEND>

 

Cutting More Cleanly

Cutting Detailed Characters and Complex Shapes

 

Dealing with Material Thickness/Hardness (Softness)

Using Narrow Material/Preventing Marking Made by the Middle Pinch Rollers

Cutting in the Same Position Repetitively <OVERLAP>

Cutting Corners Cleanly <Over Cut>

Setting Cutting Quality <QUALITY>

Setting the Amount of Offset for the Tip of the Blade <OFFSET>

Setting the Speed of the Blade During Cutting <UPSPEED>

 

Preventing and Correcting Misaligned Cutting

Using Thinner or Harder Material than Normal

Preventing Misaligned Cutting



Adjusting the Cutting Position

Adjusting the Printing Position

 

Adjusting the Cutting Quality and Saving and Reusing the
Adjusted Conditions

Saving the Cutting Conditions

Loading Cutting Conditions

 

Creating Copies of the Same Object

Cutting the Same Object Repetitively

 

Moving the Carriage at High Speed

Moving the Cutting Carriage at High Speed



Changing the Language Used for
the Display

The language for messages on the display can be selected.

Procedure

While holding down [MENU], switch on the power
switch.

 

Use [ ] to select the desired language.

 

Press [ENTER] to select the setting.

Other Things That You Can Do



Setting the Displayed Unit
The unit used in messages on the display can be selected.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

Press [ ] several times to display the screen
shown in the figure.

Press the [ ] key, the [ ] key, and then press the
[ ] key.

The screen shown in the figure below is displayed.

Use [ ] and [ ] to select the unit.

It is possible to select millimeters or inches.



 

Press [ENTER] to select the setting.

Use [MENU] to return to the screen in the figure.

 

Other Things That You Can Do



Initializing All Settings to Their
Default Values

This procedure returns all settings to their factory default values. However, the
language setting remains unchanged.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press the [ ] key, the [ ] key, the [ ] key, and
then press the [ ] key.

The screen shown in the figure below is displayed.



Press [ENTER] to execute the operation.

You are returned to the screen in the figure.

Other Things That You Can Do



Checking the Machine Status
<Self Test>

Execute a self test to check the status of the machine. Use this to check the machine
when it appears to be not operating correctly. A computer is not required in order to
carry out the self test. 
If the self test cannot be executed, the machine may have malfunctioned. Contact your
authorized Roland DG Corp. dealer.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press the [ ] key, the [ ] key, the [ ] key, and
then press the [ ] key.



Press [ENTER].

Operation is normal if the figure shown below is cut.

Other Things That You Can Do

 



Changing the Contrast of the
Display Screen

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.



Press [ ].

Use [ ] and [ ] to select the screen brightness.

Setting range: 1 to 5

Press [ENTER].

Other Things That You Can Do

 



Frequently Using Perforated
Cutting

There are two locations in which you can install the cutting carriage tool. 
Normally install it in the rear position. Install it in the front position when cutting
perforated lines.

Installing the Cutting Tool

If you enable [BLADE DETECT] and send the cutting data, the tool's installation position will be
checked before cutting starts. 
If the tool is installed in the incorrect position, operation will be paused and the following
message will be displayed to prompt you to install the tool in the correct position.

<When the cutting tool is installed in the front position and normal cutting is
being performed>

  * R = Rear

<When the cutting tool is installed in the rear position and perforated cutting is
being performed>

  * F = Front

This function is useful for users who commonly switch between normal cutting and perforated
cutting. You can use this function to prevent products from being wasted due to the tool being
installed in the incorrect position. 
When one of the messages shown above is displayed, install the cutting tool in the correct
position, and then press [PAUSE]. The pausing of machine operations is released, and the tool
position is detected again. Cutting starts if the tool installation position is correct.

Note that even if you disable [BLADE DETECT], when you send data that contains a mix
of normal cutting and perforated cutting, the second message shown above will be
displayed when normal cutting finishes.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen



shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to display the screen shown in
the figure.



Press [ENTER].

Other Things That You Can Do

 



Setting the Direction of the
Coordinate Axis for Cutting
<ROTATE>

This setting lets you set the direction of the coordinate axis for cutting. 
When set to [0deg] (default value), the origin is set to the lower-left corner of the
material. When set to [90deg], the origin is set to the lower-right corner of the
material, and the data is rotated counterclockwise by 90 degrees. Note that when
[90deg] is selected, the coordinate axis changes. 
The arrows in the following figures indicate the positive directions of the X and Y axes.

When Set to 0deg

When Set to 90deg

 Factory default setting  0deg
 Options   0deg or 90deg

Procedure



Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.

Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to set the value.



Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Extending the Cutting Area
<EXTEND>

It is possible to extend the cutting area by up to 20 mm.

 Factory default setting  0.00 mm (OFF)
 Setting range   0.1 to 10.0 mm

Depending on the design to be cut, the pinch rollers may pass over the top
of the cutting line.

Example: Setting 0 mm → 10 mm

When "EXTEND" Is Set after the Material Is Loaded

The value of W displayed on the panel and the actual cut width are different. 



When you set the value according to the above example, the panel is displayed as
shown in the figure below.

* The panel indication is 210 mm, but the actual cut width is 220
mm

When "EXTEND" Is Set before the Material Is Loaded

The value of W displayed on the panel and the actual cut width are the same. 
When you set the value according to the above example, the panel is displayed as
shown in the figure below.



Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.

Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to set the value.



Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Cutting Detailed Characters and
Complex Shapes
(SMOOTHING)

The smoothing function can be used to cut smooth curves such as arcs.

 Factory default setting  ON
 Options   ON, OFF

■ ON
When curves in cutting results are not smooth

■ OFF
When cutting small characters or complex shapes

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times.

 

Press [ ] twice.



Use [ ] and [ ] to select [ON] or [OFF].

Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Using Narrow Material/
Preventing Marking Made by the
Middle Pinch Rollers

When using narrow material and when using material that is easily marked by the
pinch rollers, use just the pinch rollers on the ends to feed the material. In this
mode, the middle pinch rollers are not used (they are disabled).

Reducing the Force of the Middle Pinch Rollers

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the
screen shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Press [ ] to display the screen shown in the



figure.

Press [ ].

Press [ ] or [ ] to display the screen shown in
the figure.

This setting will be enabled the next time the pinch rollers are lowered.

Press [ENTER].

Press [MENU] to return to the top screen.

Reducing the Force of the Middle Pinch Rollers

When using a wide sheet for which it is useful to use the middle pinch rollers in
order to prevent the material from coming loose during cutting but is also easily
marked by rollers, reduce the force with which the pinch rollers press down on the
material.

Procedure

Make sure the material is loaded in the machine.



Press [MENU] several times to display the
screen shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Press [ ] to display the screen shown in the
figure.

Press [ ].

Press [ ] or [ ] to set this to [SLIGHT].

This setting will be enabled the next time the pinch rollers are lowered.



Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do

 



Cutting in the Same Position
Repetitively
<OVERLAP>

The overlap function is used when it is not possible to cut through the material in a
single pass, for example, when cutting thick material.

 Factory default setting  OFF
 Setting range   OFF, 1 to 10

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Press [ ] several times to display the screen
shown in the figure.



Press [ ].

Use [ ] to set the number of cuts.

Setting range: 1 to 10

OVERLAP 2 → Normal cut + 2 → 3 cuts are made.

Press [ENTER].

This setting remains enabled until you disable it. If you do
not require it, disable it after use.

Press [MENU] to return to the top screen.

Other Things That You Can Do

 



Cutting Corners Cleanly
<Over Cut>

This function cuts an extra 1 mm at the start and end of each line. It is effective
when you want to produce particularly sharp corners, for example when cutting
thicker materials. 
In most cases the over cut function should be set to [OFF]. Set it to [ON] when you
want to ensure that corners are cut cleanly. However, if the over cut function is
enabled when cutting small characters or complex shapes, areas of the material that
are required may be cut. In such cases it should therefore be set to [OFF].

OFF ON

 Factory default setting  OFF
 Options   OFF, ON

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the
screen shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.



Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

 

Press [ ] to select [ON].

Press [ENTER].

This setting remains enabled until you disable it. If you
do not require it, disable it after use.

Press [MENU] to return to the top screen.



Other Things That You Can Do



Setting Cutting Quality
<QUALITY>

This setting lets you set cutting quality.

 Factory default
setting 

 NORMAL

 Options 

 NORMAL, HIGH SPEED, HEAVY 
 NORMAL: This setting should be used for normal operation.  
 HIGH SPEED: This setting should be used when you want to increase the
cutting speed.  
 HEAVY: This setting should be used when using thick or heavy material. 

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.

Press [ ].

 



Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to display the item that you want
to set.

Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Setting the Amount of Offset for
the Tip of the Blade
<OFFSET>

This setting lets you set the amount of offset for the tip of the blade. Set a value that
matches the conditions for the blade installed. 
When using the included blade or equivalent parts, cutting can be performed using the
factory default setting.

(1) Offset amount
(2) Blade tip
(3) Blade centerline

 Factory default setting  0.250 mm
 Setting range   0.000 to 1.000 mm (in 0.025 mm steps)

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.



Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to set the value.

Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Setting the Speed of the Blade
During Cutting
<UPSPEED>

This setting lets you set the speed for moving the blade to the next cutting position
with the blade lifted off the material during cutting operation. 
When this is set to [AUTO], the blade moves at the speed specified by [SPEED].
Increasing [UPSPEED] shortens the cutting time. When cutting material that is thinner
or thicker than the standard material, it may be better to decrease the speed to prevent
problems such as the material being lifted up.

 Factory default setting  AUTO
 Setting range   10 to 50 cm/s (in 10 cm/s steps), AUTO 

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.

Press [ ].

 



Press [ ] or [ ] several times to display the
screen shown in the figure.

Press [ ].

Use [ ] and [ ] to set the value.

Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Using Thinner or Harder Material
than Normal

You can use the fan to hold down the material and prevent misalignment. 
Change these settings to match the thickness and hardness of the material used.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the
screen shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

Press [ ] several times to display the screen
shown in the figure.



Press [ ].

 

Use [ ] and [ ] to select the air volume.

1: Weak ... 5: Strong, AUTO:      Automatic

Use a weaker air volume when using thin material.

Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Preventing Misaligned Cutting
Set this setting to [ON] to feed out the material automatically during cutting. 
While this setting is enabled, when cutting data is sent from the computer, cutting is
performed every 1 meter after the material has automatically been fed forward
(depending on the data, the material may be fed out more than 1 m, for example if the
next movement point is more than 1 m back). 
If material has already been fed out using the [AREA] function, the material will not be
fed out automatically until the length of material that was fed out using the [AREA]
function is reached, even if [PRE-FEED] is set to [ON].

* This function is only enabled when the material type has been set to [ROLL].

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].



Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to select [ON] or [OFF].

Setting the Material Feed Speed

When the figure shown above is displayed, press [ ] twice to display the figure
shown below.

Press [ ] and [ ] to set the speed. 

Setting range: 1 to 10

Press [ENTER].



Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do

 



Adjusting the Cutting Position
If the printing position and the cutting position are offset as shown in the following
figure, you can correct the issue by adjusting either the printing position or the
cutting position. This example shows the procedure for adjusting the cutting
position.

Adjusting the Printing Position

*1: Intended cutting line
*2: Actual cutting line

CROP-L/W Values

Input range: -25 mm to 25 mm

To move the cutting line 0.5 mm to the left → Enter the W value



*1: Intended cutting line   *2: Actual cutting line

 

To move the cutting line 0.5 mm down → Enter the L value

 

To move the cutting line 0.7 mm up and 0.5 mm to the right →
Enter both W and L values

 



1. Set the CROP-L value.

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ] twice.

The screen shown in the following figure is displayed. First enter the CROP-L
value.



Use [ ] and [ ] to enter the value.

Refer to the section above titled "CROP-L/W Values" to enter the values.

 

Press [ENTER].

The screen shown in the following figure is displayed.

 

2. Set the CROP-W value.

Press [ ].

The screen shown in the following figure is displayed. Enter the CROP-W
value.

Press [ ].

 

Use [ ] and [ ] to enter the value.



 

Press [ENTER].

When you have finished, press [MENU] to return to the screen in the figure.

Send the cutting data.

Perform cutting again and check the cutting position.

 

Other Things That You Can Do



Adjusting the Printing Position
If the printing position and the cutting position are offset as shown in the following
figure, you can correct the issue by adjusting either the printing position or the cutting
position. This example shows the procedure for adjusting the printing position.

Adjusting the Cutting Position

*1: Intended cutting line
*2: Actual cutting line

Procedure

In CutStudio, from the File menu, click Printing Setup.



 

Select the Fine adjustment check box, and then click
Adjust.



The Crop Mark Adjustment dialog box appears.

 



Align the position with respect to a line or point that is
close to the origin.

Adjust the Base X and Base Y values to eliminate the offset, and then click OK. 
Do not change the W and L values at this point.

Align the position with respect to this side.

 (1): Origin
 (2): Cutting line
 (3): Printing position
 

The Cutting Position Is Offset to the Left or Right of the Printing
Position

Change the Base X value. If the cutting position is offset to the right of the printing
position, increase the value; if it is offset to the left of the printing position, decrease
the value. In the case shown in the above figure, increase Base X.

The Cutting Position Is Offset above or below the Printing Position

Change the Base Y value. If the cutting position is offset above the printing position,
increase the value; if it is offset below the printing position, decrease the value. In
the case shown in the above figure, increase Base Y.

If the printing and cutting positions are offset at a location distant from the origin as
shown in the following figure even after adjusting the positions with Base X and
Base Y values, it is possible that the distance between the printed crop marks is
offset from the settings (W and L). This may be due to the expansion or contraction
of the material or distortion in the printing.  Proceed to step 4.

 Just the part that is distant from the origin is offset.
 



 (1): Origin
 (2): Cutting line
 (3): Printing position
 

The actual distance is longer than the W and L settings.

Set W and L in the Crop Mark Adjustment dialog box as
described below to correct the error.

However, the values are merely guidelines. The optimal values must be found by
changing the values and actually cutting the material several times.

 

CAUTION

Before changing the settings, check that the Base X and Base Y settings have been
adjusted with respect to a line or point close to the origin. If they were not, the
adjustment result of step 3 will be offset if the W and L settings are changed.

 

The Cutting Lines Are Offset Outward from the Printing Position

This may be because the distance between the printed crop marks is longer than the
setting. In this case, set the W and L values greater than the settings to make the
adjustment.



(1): Origin
(2): Cutting line
(3): Printing position
 

The Cutting Lines Are Offset Inward from the Printing Position

This may be because the distance between the printed crop marks is shorter than the
setting. In this case, set the W and L values smaller than the settings to make the
adjustment.

(1): Origin
(2): Cutting line
(3): Printing position
 

CAUTION

The values entered in the Crop Mark Adjustment dialog box are effective only when Fine
adjustment in the Printing Setup dialog box is enabled. All the entered values are
cleared if Fine adjustment is disabled or if the W and L values of Crop marks are
changed.

If the Sensor Fails to Read the Crop Marks

If the sensor fails to read the crop marks, the screen in the figure appears. If this
screen appears, proceed to "Crop Marks Cannot Be Read." 
If this does not resolve the issue, refer to "Cutting in Tool Mode (1)," and then perform
positioning in tool mode.



  Back (to "Adjusting the Cutting Position")



Saving the Cutting Conditions
The current cutting conditions can be saved to memory. 
Eight sets of settings can be saved to USER 1 to USER 8 memories. Overwriting a
memory deletes any old conditions it contains.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

Press [ ].

Press the [ ] key, the [ ] key, and then press the
[ ] key.

The display shows the values of the FORCE, SPEED, and OFFSET menus from
the left.

Use [ ] and [ ] to select the memory number you
want to save the cutting conditions to.



Press [ENTER].

The screen shown in the following figure is displayed.

Press [MENU] to return to the top screen.

 

Though not shown on the display, the UPSPEED (the speed at which
the blade moves when not cutting) and cut quality are also saved.

Loading Cutting Conditions

Other Things That You Can Do



Loading Cutting Conditions
Cutting conditions saved to memory can be loaded.
You can select the memory from USER 1 to USER 8. Note that loading cutting
conditions from memory erases any cutting conditions that have not been saved.

Saving the Cutting Conditions

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ].

 

Press the [ ] key, and then press the [ ] key.

 

Use [ ] and [ ] to select the memory number you



wish to load.

Press [ENTER] to execute the operation.

Use [MENU] to return to the screen in the figure.

Other Things That You Can Do



Cutting the Same Object
Repetitively

Replot
The data received from the computer can be saved to the machine's memory. This
data can then be recut. To recut, use the [REPLOT] menu in the display menu.

All the data received from the time the machine is put in the setup condition to the
time the setup condition is canceled is saved.

The data is not cleared even when the setup condition is canceled.

If the setup condition is canceled and the machine is then put back in the setup
condition again, the data that was saved is overwritten with the new data that is
sent from the computer.

All data is cleared when the power is turned off.

If the data stored in the machine's memory exceeds 2 MB, recutting cannot be
performed until the data has been cleared. If [REPLOT] is carried out in this
condition, [DATA OVERFLOW] appears. If no data is stored in the machine's
memory, [NO DATA] appears when [REPLOT] is selected from the menu.

Procedure

Step 1: Prepare the Data for Recutting

Step 2: Perform Recutting



CAUTION

Step 1: Prepare the Data for
Recutting

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Clear all data remaining in the machine's memory, and then send new data so that only
the required data is stored in the machine's memory.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

If [NO DATA] is displayed, proceed to step 6.

 

Press [ ].



 

Use [ ] and [ ] to select [CLEAR].

 

Press [ENTER].

The data is cleared.

 

Send data from the computer.

 

To next procedure

 



CAUTION

Step 2: Perform Recutting

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

 



Press [ENTER].

You are returned to the screen in the figure, and cutting is performed.

 

To previous procedure



Moving the Cutting Carriage at
High Speed

Press [ ] and [ ] to move the cutting carriage. Press [ ] and [ ] to move the
material.

Procedure

This function can be used when the screen shown below is displayed.

 

Press [ENTER] and one of the cursor keys ([ ], [
], [ ], and [ ]) at the same time.

 

Other Things That You Can Do



Troubleshooting

Creating or Importing Data

Changing the Darkness of an Aligned Image

Illustrator Data Cannot Be Imported

Sample Data Cannot Be Found

Crop Marks Cannot Be Read

Crop Marks Cannot Be Read

Cutting Results Are Not Clean

The Results of Cutting Are Displaced When Using the Printing and Cutting Function

The Machine Cuts the Same Area Twice

Frequently Asked Questions

Moving a Saved Symbol to a New Computer

Supported Versions of Illustrator

Supported Versions of CorelDRAW

 



Changing the Darkness of an
Aligned Image

It is possible to change the darkness of an image imported into CutStudio.

Procedure

From the File menu, click Preferences.

On the General tab, enter a value in the Image
Darkness box.

Setting range: 1 to 100%



Click OK.

 



Illustrator Data Cannot Be
Imported

Is the data saved in Illustrator 8.0 or EPS 8.0 format?

Illustrator 8.0 and EPS 8.0 are the Illustrator file formats that can be imported into
CutStudio. If using a higher version, save files as a lower version before importing.

File Formats That Can Be Imported into CutStudio

 



Sample Data Cannot Be Found

Location of Sample Data Folder
Open the Sample.bmp file found in the CutStudio installation folder (usually located
in the CutStudio folder under Program Files on the C drive).

Is the computer not set to show hidden folders?

Sample data may not be displayed in some cases depending on the computer
settings. If sample data is not displayed, follow the procedure shown below and
recheck the location of the sample data folder.

Windows 10 and Windows 8.1

Procedure

Click Explorer.

Click the folder in the lower-left corner of the desktop.

The screen shown in the following figure is displayed.



Click the View tab.

 

Select the Hidden items check box.

 



Windows 7

Procedure

From the Start menu, click Computer.

 

In the Organize menu, click Folder and search
options.

The screen shown in the following figure is displayed.



 

Click the View tab, and then select the Show
hidden files, folders, and drives option.

 



Click OK.

 



Crop Marks Cannot Be Read
When the machine cannot read crop marks, it displays an error message and pauses
operation. 
If this happens, press any key on the operation panel. Remove the material, check the
following items, and then reload the material.

"CROPMARK ERR" or "SET TO <TOOL MODE>" Is Displayed

Is the material loaded correctly?

Refer to "Using Various Types of Materials" and load the material in the correct
position.

Are you using material that is not white or is glossy?

Crop marks cannot be detected if decorations or colors are on the material. 
Crop marks also may not be detected on glossy material even if it is white.

Materials That Can Be Used for Printing and Cutting

Does the material have creases or wrinkles?

Crop marks may not be read if the material has creases or wrinkles. Stretch the
creases or wrinkles out and load the material again. 
If the crop marks still fail to be read, prepare new material without creases or
wrinkles and redo the operation from printing the data.

 

Are the crop marks blurred or are they in a color other than black?

Set the color of crop marks to black, specify 100% density, and then print the data
again.

Crop Marks



 

Are the size and shape of crop marks correct?

Make the crop marks perfect circles 10 mm (0.39 in.) in diameter. 
The machine can only detect crop marks in the prescribed shape.

Crop Marks

 

Are the crop marks at the correct positions?

Refer to "Setting the Margins and the Distance between Crop Marks" and place the
crop marks at the correct positions.

 

Is the [ROTATE] menu set to [90deg]?

Be sure to set the [ROTATE] menu to [0deg] when using crop marks. 
Crop marks cannot be read if this is set to [90deg].

Setting the Direction of the Coordinate Axis for Cutting <ROTATE>

 

Is the machine exposed to direct sunlight or strong indoor lighting?

If the cutting carriage sensor is exposed to direct sunlight or indoor lighting, crop
marks may not be detected. Move the machine to a location where it is not exposed
to direct sunlight or indoor lighting.

If the Issue Is Not Resolved Even after Taking the Above Steps

Perform alignment in Tool Mode.

Cutting in Tool Mode (1)

 

 



"LENGTH NG," "WIDTH NG," or "ANGLE TOO BIG" Is
Displayed

Is the material loaded at an angle? Are the printing results crooked?

Crop marks cannot be detected in the following cases:

The left and right crop marks are slanted by 5 degrees or more with respect to the
moving direction of the carriage.
The left and right crop marks are offset by 20 mm or more in the material-feed
direction.

Do the distances between crop marks specified by the software match
those specified on the machine? (Manual mode)

On the machine, correctly set the distance specified by the software.

 

Are the crop marks at the correct positions?

If the angle formed by the two lines connecting the centers of the crop marks is not
90 degrees, the crop marks cannot be read. Crop marks cannot be read if the
distance between crop marks in the material-feed direction is 500 mm (19.69 in.) or
more.

 

Is the printing expanded or reduced?

If the size is expanded or reduced during printing, the crop marks cannot be read
during cutting. Print the data by specifying 100% for the magnification.

 



The Results of Cutting Are
Displaced When Using the Printing
and Cutting Function

Is a thick material being used?

When using thick material, set [Cutting Quality] to [HEAVY].

Setting Cutting Quality <QUALITY>

 

When using roll material, was the amount of material to be cut pulled
out before performing cutting?

If cutting is performed without pulling out the material, the material may slip or a
motor error may stop the operation

Loading Roll Material

 

Fine-tuning the Printing Position

Adjusting the Printing Position

 

Fine-tuning the Cutting Position

Adjusting the Cutting Position

 

 



The Machine Cuts the Same Area
Twice

Is Overlap Cutting set to 0 in CutStudio?

If Overlap Cutting is set to any number other than 0 on the Cut screen, the number
is added to the number of cuts.

Is the machine's [OVERLAP] setting a number from 1 to 10?

Set the machine's [OVERLAP] setting to [OFF].

Cutting in the Same Position Repetitively <OVERLAP>

Are there overlapping lines?

The same data may have been copied, resulting in overlapping lines. Check the
data.

 



Moving a Saved Symbol to a New
Computer

For instructions on how to save symbols, check the CutStudio Help.

Procedure

Copy the Symbol folder from the path below.
Store the folder in a desired location or move it.

C:¥ProgramData¥Roland DG Corporation¥CutStudio
¥Symbol

 

If the Folder Is Not Displayed

In "Sample Data Cannot Be Found," configure the settings for displaying
hidden folders.

 

Copy the Symbol folder to a new computer.

Copy the folder to the same location on the new computer. 
If the folder is not displayed on the new computer, adjust the settings to
display hidden folders.

 



Installing Plug-in for Illustrator

Installation Procedure
Install from the following link.
http://startup.rolanddg.com/

 

Supported Versions
For information regarding the latest supported versions, visit the Roland DG Corp.
website (http://www.rolanddg.com/).

 

http://startup.rolanddg.com/
http://www.rolanddg.co.jp/


Installing Plug-in for CorelDRAW

Installation Procedure
Install from the following link.
http://startup.rolanddg.com/

 

Supported Versions
For information regarding the latest supported versions, visit the Roland DG Corp.
website (http://www.rolanddg.com/).

 

http://startup.rolanddg.com/
http://www.rolanddg.co.jp/
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Sending Data from Illustrator
You can output cutting line data drawn with Adobe Illustrator to the cutting
machine. 
To output data it is necessary to install a plug-in.

Required Items

Plug-in for Illustrator
 

Installing Plug-in for Illustrator

Install Plug-in for Illustrator on the computer on which Illustrator is installed.

Sending Data from Illustrator

Outputting Data Created in Illustrator

Viewing Help

Viewing Help (Illustrator)

http://startup.rolanddg.com/


CAUTION

Outputting Data Created in
Illustrator

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

* The screenshots show an example of Illustrator CC 2015, but the operation procedure
is the same for other versions.

You must install Plug-in for Illustrator before proceeding.

Installing Plug-in for Illustrator

Procedure

Start Illustrator.

In Illustrator, click Extensions > Roland CutStudio
from the Window menu.

The "Roland CutStudio" palette appears.

http://startup.rolanddg.com/


Create a new file and create a new design or open
an existing file.

In this example, you will create the design shown in the figure below. Change
the characters to outline data.



When you select characters and click  on the palette, the characters
change to outline data.

Select Output All Lines.



On the Roland CutStudio palette, select the Auto
Update check box.

Check that the cutting line that you wish to output is shown on the preview
screen.

Click .

The following dialog box appears.



Select the model name of the machine on hand,
and then click Cut.

The cutting data is output.



Viewing Help (Illustrator)

Procedure

On the Roland CutStudio palette, click , and then
click Help.



Printing and Cutting

Printing and Cutting Overview

Your favorite picture can be printed and cut. This makes it easy to create your own
original stickers.

Flow Diagram

Create the data in Illustrator.

 

Print the data with the printer.
(Use the printer that you have on hand.)

 

Cut the printed material.



 

Your original sticker is complete!

Materials That Can Be Used for Printing and Cutting

Materials That Can Be Used for Printing and Cutting

Printing and Cutting with Illustrator

Preparations for Printing and Cutting (When Using Illustrator)

Printing and Cutting Procedure (Illustrator)



Preparations for Printing and
Cutting (When Using Illustrator)

Printing and Cutting Sample Data
We recommend that you get comfortable with the printing and cutting procedure by
using the sample data first. 
In this procedure, you will create the sticker shown below.

Printing and Cutting Procedure (Illustrator)

Items Required Other than the Machine

Printer Material (210 x 298 mm) Sample data

A computer on which Illustrator and Plug-In for Illustrator are installed

Printer Requirements



You must use a laser or inkjet printer with a resolution of 720 dpi or greater.

If the printed filled sections are blurred, crop marks will not be read correctly.

Plug-In for Illustrator

Be sure to install this program.

Installing Plug-In for Illustrator

Material

This example uses A4-size material.

Materials That Can Be Used for Printing and Cutting

Sample Data

Use Sample.bmp, which is found in the CutStudio folder under Applications.

Printing and Cutting Procedure (Illustrator)

http://startup.rolanddg.com/


Printing and Cutting Procedure
(Illustrator)

Procedure

Step 1: Set the Printing and Cutting Areas

Step 2: Position the Sample Data

Step 3: Draw the Cutting Lines

Step 4: Perform Printing

Step 5: Load the Printed Material

Step 6: Set the Alignment Method (Sensor Mode)

Step 7: Perform Cutting (Sensor Mode)

 



Step 1: Set the Printing and
Cutting Areas

Procedure

Perform preparations for cutting.

Click the link below and perform the procedures from
"Loading Roll Material" to "Setting the Origin."

Loading Roll Material

Start Illustrator.

Open a new document, and then set the artboard.

Set the document size to be the same as the cutting width displayed on the
machine.

From the Window menu, click Extensions, and then
click Roland CutStudio.



The Roland CutStudio palette appears.

On the palette, click .

Crop marks are inserted in the artboard.



Click , and then click Crop marks.

Select the model name from the Type list, and then
select 4 from the Point list.



Point: Set the number of crop marks.

Set the margins, and then click OK.

Setting the Margins and the Distance between Crop Marks

Step 2: Position the Sample Data



Step 2: Position the Sample Data

Procedure

Position the image data in the area within the crop
marks.

 Position the data within this area.

Step 3: Draw the Cutting Lines



Step 3: Draw the Cutting Lines

Procedure

Draw the cutting lines.

Create a new layer for the cutting lines and draw the cutting lines there.

 Newly created layer

Cutting line

Save the data.

 

Step 4: Perform Printing

 



Step 4: Perform Printing

Procedure

Load the material in the printer.

For details on how to load the material, see the instruction
manual for your printer.

* When expanded/reduced printing is enabled, disable it.
Print at 100% scale.

Hide the layer containing the cutting lines.



From the File menu, click Print.

The image is printed as shown in the figure below.

 

Step 5: Load the Printed Material



Step 5: Load the Printed Material

Procedure

Check the origin for cutting of the printed material.

Turn on the cutting machine.
Wait for the initial operation to finish.

 

Set the origin for cutting to the lower-left corner of
the material, and then load the material in the
machine.

If the material is loaded in the wrong direction, the machine
will not be able to read the crop marks.



Position the left and right pinch rollers as shown in
the figure.

For A4-size material, do not use the middle pinch rollers.

Using Narrow Material/Preventing Marking Made by the Middle Pinch Rollers

(1) Position the pinch rollers outside the tool marks.
(2) Be sure that both edges of the material and the pinch rollers
are inside the grit patterns.



Align the right edge of the material with the front
and back gradations of the platen.

Select the type of material.

Using Various Types of Materials

Press [ENTER].

The pinch rolls lower and the carriage and material move. 
When the movement is finished, the cuttable width and length are displayed.

Use [ ] and [ ] to move the material and position
the crop marks above the blade protector.

(1) Blade protector
(2) Crop marks



 

Press [ ] and [ ] to position the tip of the blade
over the center of the lower-left crop mark.

Do not set the origin.

 

Crop marks cannot be read in the situations indicated below.

If any of the following situations occur, remove the material, and then reload it.

The left and right crop marks are slanted by 5 degrees or more with respect to
the moving direction of the cutting carriage.
The left and right crop marks are offset by 20 mm or more in the material-feed
direction.

The crop marks are separated from the blade protector by a distance of 15 mm



or more.

     *: Blade protector

The material sometimes curls when it is printed on the printer. 
Do not use material that is curled as shown in the figure. The crop marks may not
be read. If this happens, straighten out the material before loading it on the cutting
machine.

Step 6: Set the Alignment Method



Step 6: Set the Alignment Method
(Sensor Mode)

Position the crop marks automatically using the machine's integrated sensor.

Procedure

Press [MENU] several times to display the screen
shown in the figure.

Press [ ] several times to display the screen
shown in the figure.

Press [ ] once, and then press [ ] several times
to select [SENSOR MODE]

Press [ENTER] to select the setting.

Press [MENU] to return to the screen shown in the figure.



Step 7: Perform Cutting (Sensor Mode)



CAUTION

Step 7: Perform Cutting (Sensor
Mode)

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Procedure

Show the layer containing the cutting lines and
select it.

Check that all the cutting lines that you wish to cut are shown on the
palette's preview screen.

On the Roland CutStudio palette, select Output
Current Layer, and then click Update.

Check that all the cutting lines that you wish to cut are shown on the
palette's preview screen.

Changing the Cutting Settings



Click .

The screen shown in the following figure is displayed.

If you want to check the cutting settings, refer to "Configuring Cutting
Settings from a Computer."



Select the model name of the machine on hand,
and then click Cut.

If the model name is not displayed, see "The Machine Doesn't Run" in
"Troubleshooting."

The cutting data is sent to the machine. When the machine receives the data,
it automatically reads the crop marks using a sensor, and then starts cutting.

Crop Marks Cannot Be Read

If the Sensor Fails to Read the Crop Marks

If the sensor fails to read the crop marks, the screen in the figure appears. If
this screen appears, proceed to "Crop Marks Cannot Be Read." If this does
not resolve the issue, refer to "Cutting in Tool Mode (1)," and then perform
positioning in tool mode.

When cutting is finished, click Exit to close the
window.

To Cancel Cutting

Remove the cut material.

Remove the material to complete the cutting procedure.



Removing the Material



Setting the Margins and the
Distance between Crop Marks

Set the margins and the distance between crop marks. 
Take into account the margin necessary for cutting the material and set the crop mark
position.

When Using Illustrator

* When using material with a large amount of feed (long material), we recommend
that you set the left and right margins to approximately 25 mm.

<crop marks: 3 points>, <crop marks: 4 points>

Size Crop mark positions

A4 portrait X: 10 mm, Y: 45 mm
W: 170 mm, L: 202 mm

A4 landscape X: 10 mm, Y: 45 mm
W: 257 mm, L: 115 mm

A3 portrait X: 10 mm, Y: 45 mm
W: 257 mm, L: 325 mm

A3 landscape X: 10 mm, Y: 45 mm
W: 380 mm, L: 202 mm

B4 portrait X: 10 mm, Y: 45 mm
W: 217 mm, L: 269 mm

B4 landscape X: 10 mm, Y: 45 mm



W: 324 mm, L: 162 mm

* If you are using material that is larger than the sizes listed
above, set the values by referring to the figure below.

: Cuttable area
: Ensure that only crop marks are present within this area and that it is free of any
other illustrations and dirt.



Cutting Perforated Lines

Overview of Cutting Perforated Lines
The machine can also cut material without carrier paper, such as coated paper. 
This function makes it easy to create point-of-purchase advertisements, cards, and
other materials.

Step 1: Perform Preparations for Cutting

Step 2: Create Perforated Line Data

Step 3: Set Perforated Cutting Conditions

Step 4: Cut Perforated Lines



Step 1: Perform Preparations for
Cutting

Procedure

Perform preparations for cutting.

Click the link below and perform the procedures from
"Loading Roll Material" to "Setting the Origin." 
Exercise caution regarding the position in which the cutting
tool is installed.

Loading Roll Material

When cutting perforated lines, install the cutting tool in the position shown in the
figure. 
Note that this is the position in front of the normal installation position.

Step 2: Create Perforated Line Data



Step 2: Create Perforated Line
Data

* The screenshots show an example of Illustrator CC 2015, but the operation procedure
is the same for other versions.

* You must install Plug-in for Illustrator before proceeding.

Installing Plug-in for Illustrator

Procedure

Start Illustrator.

Open a new document, and then set the artboard.

Set the document size to be the same as the cutting width displayed on the
machine. 
Set a length that is longer than the product that you want to create.

Create a new design or open an existing file.

In this example, you will create the design shown in the figure below.

http://startup.rolanddg.com/


From the Window menu, click Extensions, and then
click Roland CutStudio.

The Roland CutStudio palette appears.



Select the object that you want to apply perforated
lines to.

Click .



Select Output Perforated Cut Lines.

On the Roland CutStudio palette, click Update.



Check that the cutting line that you wish to output is shown on the preview
screen.

Step 3: Set Perforated Cutting Conditions



Step 3: Set Perforated Cutting
Conditions

* The screenshots show an example of Illustrator CC 2015, but the operation procedure
is the same for other versions.

Procedure

On the palette, click .

If  is not displayed, refer to "Configuring Cutting Settings from a
Computer" and configure the settings.

Clear the Use Machine Settings check box.



You can now enter the values.

Enter the Perforated Cutting Conditions.

Set the length of each perforation to make in the material (the perforation
length) and the length of the part that is not perforated because the blade force
is reduced (the half-cut length). 
Adjust the half-cut force to suit the type of material or paper used.

Perforation Length/Half-cut Length

   *1: Perforation length
   *2: Half-cut length



Perforation Length > Half-Cut Length

Perforation Length = Half-Cut Length

Perforation Length < Half-Cut Length

Click OK.

Step 4: Cut Perforated Lines



CAUTION

Step 4: Cut Perforated Lines

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Procedure

On the palette, click .

The screen shown in the following figure is displayed.

Checking the Installed Position of the Cutting Tool Each Time
before Cutting

Frequently Using Perforated Cutting

Select the model name of the machine on hand,
and then click Cut.



Cutting starts.

Adjusting Perforated Cutting Conditions

Select optimum cutting conditions on the basis of the cutting results.

Optimizing the Cutting Quality for the Material



Other Things That You Can Do

Changing or Checking the Machine's Operation

Changing the Language Used for the Display

Setting the Displayed Unit

Initializing All Settings to Their Default Values

Checking the Machine Status <Self Test>

Changing the Contrast of the Display Screen

Frequently Using Perforated Cutting

 

Minimizing Wasted Material

Setting the Direction of the Coordinate Axis for Cutting <ROTATE>

Extending the Cutting Area <EXTEND>

 

Cutting More Cleanly

Cutting Detailed Characters and Complex Shapes

 

Dealing with Material Thickness/Hardness (Softness)

Using Narrow Material/Preventing Marking Made by the Middle Pinch Rollers

Cutting in the Same Position Repetitively <OVERLAP>

Cutting Corners Cleanly <Over Cut>

Setting Cutting Quality <QUALITY>

Setting the Amount of Offset for the Tip of the Blade <OFFSET>

Setting the Speed of the Blade During Cutting <UPSPEED>

 

Preventing and Correcting Misaligned Cutting

Using Thinner or Harder Material than Normal

Preventing Misaligned Cutting



Adjusting the Cutting Position

 

Adjusting the Cutting Quality and Saving and Reusing the
Adjusted Conditions

Saving the Cutting Conditions

Loading Cutting Conditions

 

Creating Copies of the Same Object

Cutting the Same Object Repetitively

 

Moving the Carriage at High Speed

Moving the Cutting Carriage at High Speed



Changing the Language Used for
the Display

The language for messages on the display can be selected.

Procedure

While holding down [MENU], switch on the power
switch.

 

Use [ ] to select the desired language.

 

Press [ENTER] to select the setting.

Other Things That You Can Do



Setting the Displayed Unit
The unit used in messages on the display can be selected.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

Press [ ] several times to display the screen
shown in the figure.

Press the [ ] key, the [ ] key, and then press the
[ ] key.

The screen shown in the figure below is displayed.

Use [ ] and [ ] to select the unit.

It is possible to select millimeters or inches.



 

Press [ENTER] to select the setting.

Use [MENU] to return to the screen in the figure.

 

Other Things That You Can Do



Initializing All Settings to Their
Default Values

This procedure returns all settings to their factory default values. However, the
language setting remains unchanged.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press the [ ] key, the [ ] key, the [ ] key, and
then press the [ ] key.

The screen shown in the figure below is displayed.



Press [ENTER] to execute the operation.

You are returned to the screen in the figure.

Other Things That You Can Do



Checking the Machine Status
<Self Test>

Execute a self test to check the status of the machine. Use this to check the machine
when it appears to be not operating correctly. A computer is not required in order to
carry out the self test. 
If the self test cannot be executed, the machine may have malfunctioned. Contact your
authorized Roland DG Corp. dealer.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press the [ ] key, the [ ] key, the [ ] key, and
then press the [ ] key.



Press [ENTER].

Operation is normal if the figure shown below is cut.

Other Things That You Can Do

 



Changing the Contrast of the
Display Screen

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.



Press [ ].

Use [ ] and [ ] to select the screen brightness.

Setting range: 1 to 5

Press [ENTER].

Other Things That You Can Do

 



Frequently Using Perforated
Cutting

There are two locations in which you can install the cutting carriage tool. 
Normally install it in the rear position. Install it in the front position when cutting
perforated lines.

Installing the Cutting Tool

If you enable [BLADE DETECT] and send the cutting data, the tool's installation position will be
checked before cutting starts. 
If the tool is installed in the incorrect position, operation will be paused and the following
message will be displayed to prompt you to install the tool in the correct position.

<When the cutting tool is installed in the front position and normal cutting is
being performed>

  * R = Rear

<When the cutting tool is installed in the rear position and perforated cutting is
being performed>

  * F = Front

This function is useful for users who commonly switch between normal cutting and perforated
cutting. You can use this function to prevent products from being wasted due to the tool being
installed in the incorrect position. 
When one of the messages shown above is displayed, install the cutting tool in the correct
position, and then press [PAUSE]. The pausing of machine operations is released, and the tool
position is detected again. Cutting starts if the tool installation position is correct.

Note that even if you disable [BLADE DETECT], when you send data that contains a mix
of normal cutting and perforated cutting, the second message shown above will be
displayed when normal cutting finishes.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen



shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to display the screen shown in
the figure.



Press [ENTER].

Other Things That You Can Do

 



Setting the Direction of the
Coordinate Axis for Cutting
<ROTATE>

This setting lets you set the direction of the coordinate axis for cutting. 
When set to [0deg] (default value), the origin is set to the lower-left corner of the
material. When set to [90deg], the origin is set to the lower-right corner of the
material, and the data is rotated counterclockwise by 90 degrees. Note that when
[90deg] is selected, the coordinate axis changes. 
The arrows in the following figures indicate the positive directions of the X and Y axes.

When Set to 0deg

When Set to 90deg

 Factory default setting  0deg
 Options   0deg or 90deg

Procedure



Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.

Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to set the value.



Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Extending the Cutting Area
<EXTEND>

It is possible to extend the cutting area by up to 20 mm.

 Factory default setting  0.00 mm (OFF)
 Setting range   0.1 to 10.0 mm

Depending on the design to be cut, the pinch rollers may pass over the top
of the cutting line.

Example: Setting 0 mm → 10 mm

When "EXTEND" Is Set after the Material Is Loaded

The value of W displayed on the panel and the actual cut width are different. 



When you set the value according to the above example, the panel is displayed as
shown in the figure below.

* The panel indication is 210 mm, but the actual cut width is 220
mm

When "EXTEND" Is Set before the Material Is Loaded

The value of W displayed on the panel and the actual cut width are the same. 
When you set the value according to the above example, the panel is displayed as
shown in the figure below.



Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.

Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to set the value.



Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Cutting Detailed Characters and
Complex Shapes
(SMOOTHING)

The smoothing function can be used to cut smooth curves such as arcs.

 Factory default setting  ON
 Options   ON, OFF

■ ON
When curves in cutting results are not smooth

■ OFF
When cutting small characters or complex shapes

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times.

 

Press [ ] twice.



Use [ ] and [ ] to select [ON] or [OFF].

Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Using Narrow Material/
Preventing Marking Made by the
Middle Pinch Rollers

When using narrow material and when using material that is easily marked by the
pinch rollers, use just the pinch rollers on the ends to feed the material. In this
mode, the middle pinch rollers are not used (they are disabled).

Reducing the Force of the Middle Pinch Rollers

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the
screen shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Press [ ] to display the screen shown in the



figure.

Press [ ].

Press [ ] or [ ] to display the screen shown in
the figure.

This setting will be enabled the next time the pinch rollers are lowered.

Press [ENTER].

Press [MENU] to return to the top screen.

Reducing the Force of the Middle Pinch Rollers

When using a wide sheet for which it is useful to use the middle pinch rollers in
order to prevent the material from coming loose during cutting but is also easily
marked by rollers, reduce the force with which the pinch rollers press down on the
material.

Procedure

Make sure the material is loaded in the machine.



Press [MENU] several times to display the
screen shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Press [ ] to display the screen shown in the
figure.

Press [ ].

Press [ ] or [ ] to set this to [SLIGHT].

This setting will be enabled the next time the pinch rollers are lowered.



Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do

 



Cutting in the Same Position
Repetitively
<OVERLAP>

The overlap function is used when it is not possible to cut through the material in a
single pass, for example, when cutting thick material.

 Factory default setting  OFF
 Setting range   OFF, 1 to 10

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Press [ ] several times to display the screen
shown in the figure.



Press [ ].

Use [ ] to set the number of cuts.

Setting range: 1 to 10

OVERLAP 2 → Normal cut + 2 → 3 cuts are made.

Press [ENTER].

This setting remains enabled until you disable it. If you do
not require it, disable it after use.

Press [MENU] to return to the top screen.

Other Things That You Can Do

 



Cutting Corners Cleanly
<Over Cut>

This function cuts an extra 1 mm at the start and end of each line. It is effective
when you want to produce particularly sharp corners, for example when cutting
thicker materials. 
In most cases the over cut function should be set to [OFF]. Set it to [ON] when you
want to ensure that corners are cut cleanly. However, if the over cut function is
enabled when cutting small characters or complex shapes, areas of the material that
are required may be cut. In such cases it should therefore be set to [OFF].

OFF ON

 Factory default setting  OFF
 Options   OFF, ON

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the
screen shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.



Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

 

Press [ ] to select [ON].

Press [ENTER].

This setting remains enabled until you disable it. If you
do not require it, disable it after use.

Press [MENU] to return to the top screen.



Other Things That You Can Do



Setting Cutting Quality
<QUALITY>

This setting lets you set cutting quality.

 Factory default
setting 

 NORMAL

 Options 

 NORMAL, HIGH SPEED, HEAVY 
 NORMAL: This setting should be used for normal operation.  
 HIGH SPEED: This setting should be used when you want to increase the
cutting speed.  
 HEAVY: This setting should be used when using thick or heavy material. 

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.

Press [ ].

 



Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to display the item that you want
to set.

Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Setting the Amount of Offset for
the Tip of the Blade
<OFFSET>

This setting lets you set the amount of offset for the tip of the blade. Set a value that
matches the conditions for the blade installed. 
When using the included blade or equivalent parts, cutting can be performed using the
factory default setting.

(1) Offset amount
(2) Blade tip
(3) Blade centerline

 Factory default setting  0.250 mm
 Setting range   0.000 to 1.000 mm (in 0.025 mm steps)

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.



Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to set the value.

Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Setting the Speed of the Blade
During Cutting
<UPSPEED>

This setting lets you set the speed for moving the blade to the next cutting position
with the blade lifted off the material during cutting operation. 
When this is set to [AUTO], the blade moves at the speed specified by [SPEED].
Increasing [UPSPEED] shortens the cutting time. When cutting material that is thinner
or thicker than the standard material, it may be better to decrease the speed to prevent
problems such as the material being lifted up.

 Factory default setting  AUTO
 Setting range   10 to 50 cm/s (in 10 cm/s steps), AUTO 

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] to display the screen shown in the
figure.

Press [ ].

 



Press [ ] or [ ] several times to display the
screen shown in the figure.

Press [ ].

Use [ ] and [ ] to set the value.

Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Using Thinner or Harder Material
than Normal

You can use the fan to hold down the material and prevent misalignment. 
Change these settings to match the thickness and hardness of the material used.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the
screen shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

Press [ ] several times to display the screen
shown in the figure.



Press [ ].

 

Use [ ] and [ ] to select the air volume.

1: Weak ... 5: Strong, AUTO:      Automatic

Use a weaker air volume when using thin material.

Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do



Preventing Misaligned Cutting
Set this setting to [ON] to feed out the material automatically during cutting. 
While this setting is enabled, when cutting data is sent from the computer, cutting is
performed every 1 meter after the material has automatically been fed forward
(depending on the data, the material may be fed out more than 1 m, for example if the
next movement point is more than 1 m back). 
If material has already been fed out using the [AREA] function, the material will not be
fed out automatically until the length of material that was fed out using the [AREA]
function is reached, even if [PRE-FEED] is set to [ON].

* This function is only enabled when the material type has been set to [ROLL].

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].



Press [ ] several times to display the screen
shown in the figure.

Press [ ].

Use [ ] and [ ] to select [ON] or [OFF].

Setting the Material Feed Speed

When the figure shown above is displayed, press [ ] twice to display the figure
shown below.

Press [ ] and [ ] to set the speed. 

Setting range: 1 to 10

Press [ENTER].



Press [ENTER].

Press [MENU] to return to the top screen.

Other Things That You Can Do

 



Adjusting the Cutting Position
If the printing position and the cutting position are offset as shown in the following
figure, you can correct the issue by adjusting either the printing position or the
cutting position. This example shows the procedure for adjusting the cutting
position.

Adjusting the Printing Position

*1: Intended cutting line
*2: Actual cutting line

CROP-L/W Values

Input range: -25 mm to 25 mm

To move the cutting line 0.5 mm to the left → Enter the W value



*1: Intended cutting line   *2: Actual cutting line

 

To move the cutting line 0.5 mm down → Enter the L value

 

To move the cutting line 0.7 mm up and 0.5 mm to the right →
Enter both W and L values

 



1. Set the CROP-L value.

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

 

Press [ ] several times to display the screen
shown in the figure.

Press [ ] twice.

The screen shown in the following figure is displayed. First enter the CROP-L
value.



Use [ ] and [ ] to enter the value.

Refer to the section above titled "CROP-L/W Values" to enter the values.

 

Press [ENTER].

The screen shown in the following figure is displayed.

 

2. Set the CROP-W value.

Press [ ].

The screen shown in the following figure is displayed. Enter the CROP-W
value.

Press [ ].

 

Use [ ] and [ ] to enter the value.



 

Press [ENTER].

When you have finished, press [MENU] to return to the screen in the figure.

Send the cutting data.

Perform cutting again and check the cutting position.

 

Other Things That You Can Do



Saving the Cutting Conditions
The current cutting conditions can be saved to memory. 
Eight sets of settings can be saved to USER 1 to USER 8 memories. Overwriting a
memory deletes any old conditions it contains.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

Press [ ].

Press the [ ] key, the [ ] key, and then press the
[ ] key.

The display shows the values of the FORCE, SPEED, and OFFSET menus from
the left.

Use [ ] and [ ] to select the memory number you
want to save the cutting conditions to.



Press [ENTER].

The screen shown in the following figure is displayed.

Press [MENU] to return to the top screen.

 

Though not shown on the display, the UPSPEED (the speed at which
the blade moves when not cutting) and cut quality are also saved.

Loading Cutting Conditions

Other Things That You Can Do



Loading Cutting Conditions
Cutting conditions saved to memory can be loaded.
You can select the memory from USER 1 to USER 8. Note that loading cutting
conditions from memory erases any cutting conditions that have not been saved.

Saving the Cutting Conditions

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ].

 

Press the [ ] key, and then press the [ ] key.

 

Use [ ] and [ ] to select the memory number you



wish to load.

Press [ENTER] to execute the operation.

Use [MENU] to return to the screen in the figure.

Other Things That You Can Do



Cutting the Same Object
Repetitively

Replot
The data received from the computer can be saved to the machine's memory. This
data can then be recut. To recut, use the [REPLOT] menu in the display menu.

All the data received from the time the machine is put in the setup condition to the
time the setup condition is canceled is saved.

The data is not cleared even when the setup condition is canceled.

If the setup condition is canceled and the machine is then put back in the setup
condition again, the data that was saved is overwritten with the new data that is
sent from the computer.

All data is cleared when the power is turned off.

If the data stored in the machine's memory exceeds 2 MB, recutting cannot be
performed until the data has been cleared. If [REPLOT] is carried out in this
condition, [DATA OVERFLOW] appears. If no data is stored in the machine's
memory, [NO DATA] appears when [REPLOT] is selected from the menu.

Procedure

Step 1: Prepare the Data for Recutting

Step 2: Perform Recutting



CAUTION

Step 1: Prepare the Data for
Recutting

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Clear all data remaining in the machine's memory, and then send new data so that only
the required data is stored in the machine's memory.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

If [NO DATA] is displayed, proceed to step 6.

 

Press [ ].



 

Use [ ] and [ ] to select [CLEAR].

 

Press [ENTER].

The data is cleared.

 

Send data from the computer.

 

To next procedure

 



CAUTION

Step 2: Perform Recutting

Never touch the cutting carriage while output is in
progress. 
The cutting carriage moves at high speed. Coming into
contact with the moving carriage may cause injury.

Procedure

Make sure the material is loaded in the machine.

Press [MENU] several times to display the screen
shown in the figure.

 

Press [ ] several times to display the screen
shown in the figure.

 

Press [ ].

 



Press [ENTER].

You are returned to the screen in the figure, and cutting is performed.

 

To previous procedure



Moving the Cutting Carriage at
High Speed

Press [ ] and [ ] to move the cutting carriage. Press [ ] and [ ] to move the
material.

Procedure

This function can be used when the screen shown below is displayed.

 

Press [ENTER] and one of the cursor keys ([ ], [
], [ ], and [ ]) at the same time.

 

Other Things That You Can Do



Troubleshooting

Crop Marks Cannot Be Read

Crop Marks Cannot Be Read

Cutting Results Are Not Clean

The Results of Cutting Are Displaced When Using the Printing and Cutting Function

The Machine Cuts the Same Area Twice

Frequently Asked Questions

Supported Versions of Illustrator

 



Crop Marks Cannot Be Read
When the machine cannot read crop marks, it displays an error message and pauses
operation. 
If this happens, press any key on the operation panel. Remove the material, check the
following items, and then reload the material.

"CROPMARK ERR" or "SET TO <TOOL MODE>" Is Displayed

Is the material loaded correctly?

Refer to "Using Various Types of Materials" and load the material in the correct
position.

Are you using material that is not white or is glossy?

Crop marks cannot be detected if decorations or colors are on the material. 
Crop marks also may not be detected on glossy material even if it is white.

Materials That Can Be Used for Printing and Cutting

Does the material have creases or wrinkles?

Crop marks may not be read if the material has creases or wrinkles. Stretch the
creases or wrinkles out and load the material again. 
If the crop marks still fail to be read, prepare new material without creases or
wrinkles and redo the operation from printing the data.

 

Are the crop marks blurred or are they in a color other than black?

Set the color of crop marks to black, specify 100% density, and then print the data
again.

Crop Marks



 

Are the size and shape of crop marks correct?

Make the crop marks perfect circles 10 mm (0.39 in.) in diameter. 
The machine can only detect crop marks in the prescribed shape.

Crop Marks

 

Are the crop marks at the correct positions?

Refer to "Setting the Margins and the Distance between Crop Marks" and place the
crop marks at the correct positions.

 

Is the [ROTATE] menu set to [90deg]?

Be sure to set the [ROTATE] menu to [0deg] when using crop marks. 
Crop marks cannot be read if this is set to [90deg].

Setting the Direction of the Coordinate Axis for Cutting <ROTATE>

 

Is the machine exposed to direct sunlight or strong indoor lighting?

If the cutting carriage sensor is exposed to direct sunlight or indoor lighting, crop
marks may not be detected. Move the machine to a location where it is not exposed
to direct sunlight or indoor lighting.

If the Issue Is Not Resolved Even after Taking the Above Steps

Perform alignment in Tool Mode.

Cutting in Tool Mode (1)

 

 



"LENGTH NG," "WIDTH NG," or "ANGLE TOO BIG" Is
Displayed

Is the material loaded at an angle? Are the printing results crooked?

Crop marks cannot be detected in the following cases:

The left and right crop marks are slanted by 5 degrees or more with respect to the
moving direction of the carriage.
The left and right crop marks are offset by 20 mm or more in the material-feed
direction.

Do the distances between crop marks specified by the software match
those specified on the machine? (Manual mode)

On the machine, correctly set the distance specified by the software.

 

Are the crop marks at the correct positions?

If the angle formed by the two lines connecting the centers of the crop marks is not
90 degrees, the crop marks cannot be read. Crop marks cannot be read if the
distance between crop marks in the material-feed direction is 500 mm (19.69 in.) or
more.

 

Is the printing expanded or reduced?

If the size is expanded or reduced during printing, the crop marks cannot be read
during cutting. Print the data by specifying 100% for the magnification.

 



The Results of Cutting Are
Displaced When Using the Printing
and Cutting Function

Is a thick material being used?

When using thick material, set [Cutting Quality] to [HEAVY].

Setting Cutting Quality <QUALITY>

 

When using roll material, was the amount of material to be cut pulled
out before performing cutting?

If cutting is performed without pulling out the material, the material may slip or a
motor error may stop the operation

Loading Roll Material

 

Fine-tuning the Cutting Position

Adjusting the Cutting Position

 

 



The Machine Cuts the Same Area
Twice

Is Overlap Cutting set to 0 in the cutting settings?

If Overlap Cutting is set to any number other than 0 on the Cut Setting screen in
Plug-in for Illustrator, the number is added to the number of cuts.

Is the machine's [OVERLAP] setting a number from 1 to 9?

Set the machine's [OVERLAP] setting to [OFF].

Cutting in the Same Position Repetitively <OVERLAP>

Are there overlapping lines?

The same data may have been copied, resulting in overlapping lines. Check the
data.

 



Installing Plug-in for Illustrator

Installation Procedure
Install from the following link.
http://startup.rolanddg.com/

 

Supported Versions
For information regarding the latest supported versions, visit the Roland DG Corp.
website (http://www.rolanddg.com/).

 

http://startup.rolanddg.com/
http://www.rolanddg.co.jp/
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